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Προλογίζοντας...

Αυτή είναι η 2η δηµοσίευση του Οδηγού που ϕιλοξενεί ο Τήλαφος0.1. Το κείµενο
µεταφέρθηκε από το OpenOffice.org στον επεξεργαστή εγγράφων LYX0.2, αναδιαρθρώθηκε
και ξαναγράφτηκε για να γίνει όσο το δυνατόν πιο ευανάγνωστο, τόσο εννοιολογικά όσο
και αισϑητικά.

Προστέθηκε ένα µέρος καθαρά τεχνικό στο οποίο περιγράφεται ϐήµα προς ϐήµα η
αναπαραγωγή του χάρτη CORINE για την Ελλάδα (εντολές και όσο το δυνατόν πιο σύν-
τοµα σχόλια). Επιπλέον στόχος του 2ου µέρους, ακολουθώντας συγκεκριµένο τρόπο
περιγραφής, είναι η παρουσίαση µιας σηµαντικής πτυχής του τρόπου µε τον οποίο
επικοινωνούν τα µέλη της λίστας GRASS-user και όχι µόνο: όσο το δυνατόν πιο σύν-
τοµη, συγκεκριµένη και τακτοποιηµένη παρουσίαση ενός προβλήµατος ή µιας κάποιας
λύσης, ώστε να µπορεί να παρακολουθήσει και να κατανοήσει την εκάστοτε συζήτηση,
και να συµµετάσχει αν το ϑελήσει, οποιοσδήποτε αναγνώστης άµεσα ή µελλοντικά.

Ο οδηγός απευθύνεται σε όσους ενδιαφέρονται να χρησιµοποιήσουν τη ϐάση δεδοµένων
κάλυψης/χρήσης γης CORINE0.3, παρουσιάζοντας µια µέθοδο αναπαραγωγής του χάρτη
CORINE για την Πελοπόννησο (µέρος II) και για ολόκληϱη την Ελλάδα (µέρος III) . Η
µέθοδος µπορεί να εφαρµοστεί για οποιαδήποτε περιοχή στην Ευρώπη την οποία και
καλύπτει ο εν λόγω χάρτης.

∆υο πιθανοί χρήστες της µεθόδου που παρουσιάζεται είναι ο περιβαλλοντολόγος/ δα-
σολόγος που ϑέλει να εκτιµήσει χοντρικά το µέγεθος της καταστροφής των δασικών
πυρκαγιών ανά κατηγορία κάλυψης γης, και ο ϕοιτητής που ϑέλει να αναλύσει στατισ-
τικά δεδοµένα π.χ. σχετικά µε την έκταση των λιµνών στην Ελλάδα, καθώς και χρήστες
συστηµάτων GIS εν γένει. Προϋποθέτει ότι ο αναγνώστης γνωρίζει περί των Συστηµάτων
Γεωγραφικών Πληροφοριών (ΣΓΠ0.4), κατέχει ϐασικές γνώσεις της Αγγλικής γλώσσας
και της επιστήµης της Πληροφορικής, χειρισµού του ηλεκτρονικού υπολογιστή και
πλοήγησης στο διαδίκτυο και έχει το ενδιαφέρον να ενηµερωθεί, µέσα από την πτυχή
της χρηστικής αξίας του λογισµικού GRASS που παρουσιάζει το κείµενο, για την νόµιµη
και δίχως κανένα κόστος χρήση εργαλείων ανοιχτού λογισµικού.

0.1http://tilaphos.googlepages.com/CORINE_withGRASS_gr.pdf
0.2http://www.lyx.org
0.3Σε όλο το έγγραφο ο όρος CORINE αναφέρεται στην ϐάση δεδοµένων CORINE2000
0.4Μετάφραση του ακρωνυµίου GIS

http://tilaphos.googlepages.com/CORINE_withGRASS_gr.pdf
http://www.lyx.org
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Περίληψη

Ο οδηγός περιγράφει ϐήµα προς ϐήµα την αξιοποίηση πληροφοριών από τη ϐάση δε-
δοµένων CORINE µε το ελεύθερο ανοιχτού κώδικα Σύστηµα Γεωγραφικών Πληροφοριών
GRASS υπό το λειτουργικό σύστηµα Ubuntu-Linux0.5, 0.6.

Η ϐάση δεδοµένων CORINE είναι ένας χάρτης κάλυψης/ χρήσης της γήινης επιφάνειας
που καλύπτει την Ευρωπαϊκή ΄Ενωση και διατίθεται χωρίς κόστος στο διαδίκτυο. Οι όροι
χρήσης του χάρτη CORINE τοποθετήθηκαν στο τέλος του 1ου κεφαλαίου στη σελίδα 17.

Το κείµενο µεταβαίνει οµαλά από τη χρήση του γραφικού περιβάλλοντος εργασίας του
GRASS στην χρήση της γραµµής εντολών (ϕλοιό) του. Ωστόσο δεν αναλύονται Ϲητήµατα
εγκατάστασης του λειτουργικού συστήµατος και του λογισµικού. Ο αναγνώστης µπορεί
να αναζητήσει πληροφορίες και υποστήριξη στις επίσηµες ιστοσελίδες του λογισµικού.

Η δοµή του κειµένου είναι η εξής:

• Μέρος I

◦ Το 1ο κεφάλαιο αναφέρεται συνοπτικά στο χάρτη CORINE και σε σηµαντικές
τεχνικές λεπτοµέρειες.

◦ Το 2ο κεφάλαιο επιχειρεί να εισαγάγει τον αναγνώστη στη λογική δοµή της
ϐάσης των γεωχωρικών δεδοµένων του GRASS.

• Μέρος II

◦ Το 3ο κεφάλαιο αναφέρεται στη λήψη της ακτογραµµής της Πελοποννήσου,
την εισαγωγή της στη ϐάση δεδοµένων και την επεξεργασία της.

◦ Τα κεφάλαια 4 έως 10 παρουσιάζουν πρακτικά την αξιοποίηση διανυσ-
µατικών χαρτών CORINE µε τη χρήση του GRASS (αναπαραγωγή του χάρτη
για την Πελοπόννησο).

0.5Η µέθοδος που παρουσιάζει ο παρών οδηγός, καθώς και η συγγραφή του ίδιου του οδηγού,
υλοποιήθηκαν υπό το ελεύθερο ανοιχτού κώδικα λειτουργικό σύστηµα Ubunut-Linux. Πληροφορίες
για πάσης ϕύσεως ερωτήµατα σχετικά µε το Ubuntu στην ελληνική γλώσσα µπορούν να αναζητηθούν
στον ιστότοπο της ελληνικής κοινότητας Ubuntu. Το GRASS-GIS όµως λειτουργεί απροβληµάτιστα στην
πλειονότητα των διανοµών Linux καθώς και σε άλλα λειτουργικά συστήµατα.

0.6http://ubuntu-gr.org

http://ubuntu-gr.org


• Μέρος III

◦ Τα κεφάλαια 11 έως 14 παρουσιάζουν τα ϐήµατα-εντολές για την αναπαραγ-
ωγή του χάρτη για ολόκληρη την Ελλάδα.

• Παράρτηµα

◦ Στο παράρτηµα υπάρχει (A) η ταξινόµηση του 3ου επιπέδου των κατηγοριών
του χάρτη CORINE στην ελληνική γλώσσα (ενδεικτική µετάφραση) και (B)
τυπωµένο ένα αρχείο που περιέχει την ονοµατολογία (όλων των επιπέδων)
και τους επίσηµους χρωµατικούς συνδυασµούς σε µορφή έτοιµη για χρήση
από το GRASS ή εφαρµογές λογιστικών ϕύλλων.

12



Επεξηγηµατικές σηµειώσεις

• το user-id πρέπει να αντικατασταθεί µε το πραγµατικό όνοµα χρήστη όπου και
όταν χρειάζεται

• οι εντολές είναι γραµµένες µε µονοδιάστατη γραµµατοσειρά και ξεκινούν µε το
σύµβολο του µεγαλυτέρου >, π.χ.: > g.proj −p

• τα µηνύµατα εξόδου που ακολουθούν τις εντολές είναι γραµµένα µε την ίδια
γραµµατοσειρά π.χ.: Trying to open with OGR...

• Οι τρεις τελείες µέσα σε αγκύλες [...] σηµαίνουν πολλές γραµµές µηνύµατος
εξόδου

• Οι ενέργειες µε το ποντίκι είναι χρωµατισµένες µπλε

• �� ��Σηµαντικές παρατηρήσεις παρουσιάζονται µέσα σε πλαίσιο.

• Ειδικά για το III µέρος Αναπαραγωγή του “ελληνικού” χάρτη CORINE :

◦ Σύντοµα σχόλια που επεξηγούν εντολές ξεκινούν µε το χαρακτήρα #

◦ Η αναπαραγωγή του χάρτη CORINE για την Ελλάδα (µέρος III) είναι χρονοβό-
ϱα εξαιτίας του όγκου των δεδοµένων! Μια εναλλακτική λύση είναι η χρήση
του ψηφιδωτού χάρτη CORINE µε ανάλυση (µέγεθος εικονοστοιχείων 100µ
x 100µ, ϐλέπε ιστότοπο του ΕΟΠ)

◦ οι κατάλογοι στους οποίους είναι αποθηκευµένα τα δεδοµένα και η ϐάση
δεδοµένων GRASS, πρέπει να προσαρµοστούν στις ανάγκες και επιθυµίες
του χρήστη.





Μέρος I

Ο χάρτης CORINE και το GRASS-GIS
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1 Ο ευρωπαϊκός χάρτης κάλυψης/χρήσης γης
CORINE

Ο Ευρωπαϊκός Οργανισµός Περιβάλλοντος (EΟΠ1.1) προσϕέρει χωρίς κόστος και για
µη εµπορική χρήση1.2 το χάρτη κάλυψης/ χρήσης γης CORINE1.3, 1.4. Ο χάρτης είναι
επίσηµα αναγνωρισµένος από τα ευρωπαϊκά κράτη και αποτελεί δηµόσιο δεδοµένο.
Η χρήση του για εφαρµογές µε εµπορικό χαρακτήρα προϋποθέτει αίτηση για ειδική
εµπορική άδεια. Οι όροι χρήσης του χάρτη CORINE είναι (αντιγραφή από τον ιστότοπο του
ΕΟΠ):

EEA grants free access to all its data/applications provided that the user agrees:

• to acknowledge the source as follows: Copyright EEA, Copenhagen, 2007

• to display a link to the EEA web site http://www.eea.europa.eu

• not to use the data/ applications for commercial purposes unless the Agency has expressly
granted the right to do so

∆ιατίθεται τόσο σε διανυσµατική (vector) όσο και σε ψηφιδωτή µορφή (raster)1.5. Για την
λήψη και την χρήση πληροφοριών από την ϐάση δεδοµένων CORINE είναι απαραίτητη
η δηµιουργία ενός λογαριασµού χρήστη1.6. O χάρτης είναι τεµαχισµένος σε πλακίδια τα
οποία µπορούν να ληφθούν ως αρχεία ESRI Shapefile(s)1.7. O οδηγός παρουσιάζει την
αξιοποίηση του διανυσµατικού χάρτη µε δεδοµένα που έχουν ληφθεί από τον ιστότοπο
του ΕΟΠ τον Ιανουάριο του 2009.

∆υο σηµαντικά στοιχεία που αφορούν στις προδιαγραφές του χάρτη είναι:
1.1http://www.eea.europa.eu
1.2http://dataservice.eea.europa.eu/dataservice/termsofuse.asp
1.3http://reports.eea.europa.eu/COR0-landcover/en
1.4Η επίσηµη ανακοίνωση παρουσίασης του χάρτη από τον EΟΠ στα Ελληνικά (Νοέµβριος, 2004): http:

//www.eea.europa.eu/pressroom/newsreleases/CLC2000-el
1.5Ανάλυση 100 και 250µ αντίστοιχα

• (100µ) http://dataservice.eea.europa.eu/dataservice/metadetails.asp?id=
1007

• (250µ) http://dataservice.eea.europa.eu/dataservice/metadetails.asp?id=
1008

1.6Οδηγίες υπάρχουν στον ιστότοπο:
http://dataservice.eea.europa.eu/dataservice/datauser.asp

1.7http://www.eea.europa.eu/themes/landuse/clc-download?configfile=config_
clcdownload.xml

http://www.eea.europa.eu
http://www.eea.europa.eu
http://dataservice.eea.europa.eu/dataservice/termsofuse.asp
http://reports.eea.europa.eu/COR0-landcover/en
http://www.eea.europa.eu/pressroom/newsreleases/CLC2000-el
http://www.eea.europa.eu/pressroom/newsreleases/CLC2000-el
http://dataservice.eea.europa.eu/dataservice/metadetails.asp?id=1007
http://dataservice.eea.europa.eu/dataservice/metadetails.asp?id=1007
http://dataservice.eea.europa.eu/dataservice/metadetails.asp?id=1008
http://dataservice.eea.europa.eu/dataservice/metadetails.asp?id=1008
http://dataservice.eea.europa.eu/dataservice/datauser.asp
http://www.eea.europa.eu/themes/landuse/clc-download?configfile=config_clcdownload.xml
http://www.eea.europa.eu/themes/landuse/clc-download?configfile=config_clcdownload.xml


1 Ο ευρωπαϊκός χάρτης κάλυψης/χρήσης γης CORINE

Εικόνα 1.1: Ο ευρωπαϊκός χάρτης κάλυψης/χρήση γης CORINE 2000

1. η ελάχιστη µονάδα χαρτογράφησης (MMU1.8) η οποία είναι ορισµένη στα 25 εκτάρια.
Πρακτικά αυτό σηµαίνει ότι οποιαδήποτε επιφάνεια που καλύπτεται από την ίδια κατη-
γορία κάλυψης της γης (π.χ. δάσος πλατύφυλλων, ϑαµνώνας) ή χρήσης της γης (π.χ.
αθλητικές εγκαταστάσεις) και είναι σε έκταση µικρότερη από 25 εκτάρια, δεν έχει χαρ-
τογραφηθεί.

2. το γεγονός ότι, ϐάσει του συστήµατος ταξινόµησης της κάλυψης γης Land Cover Clas-
sification System1.9 του Παγκόσµιου Οργανισµού Τροφίµων (FAO), µερικοί ορισµοί των
κατηγοριών κάλυψης/χρήσης γης CORINE αλληλοεπικαλύπτονται. Αυτό έχει ως αποτέλεσµα
η ϐάση δεδοµένων CORINE να µην επιτυγχάνει πλήρη εσωτερική ενότητα.

Μια προσεκτική παρατήρηση του χάρτη CORINE αποκαλύπτει και κάποια σφάλµατα.
Αυτά µπορεί να οφείλονται σε αντικειµενικές δυσκολίες σχετικές µε την παραγωγή
του χάρτη ή κακή ψηφιοποίηση. Για παράδειγµα δυσκολίες ερµηνείας των δορυ-
ϕορικών εικόνων που χρησιµοποιήθηκαν ως πρώτες ύλες εξαιτίας µεγάλου ποσοστού
νεφοκάλυψης ή µη ικανοποιητική γεωµετρική ανάλυση των εικόνων για την αναγνώρ-
ιση συγκεκριµένων κατηγοριών κάλυψης / χρήσης γης. Είναι όµως σηµαντικό να µην
ξεχνά κανείς την ελάχιστη µονάδα χαρτογράφησης που προαναφέρθηκε. Οι τεχνικές
λεπτοµέρειες της παραγωγής του χάρτη περιγράφονται σε επίσηµα εγχειρίδια1.10, 1.11.
1.8Minimum Mapping Unit
1.9Land Cover Classification System, version 2, by Antonio di Gregorio – Classification con-

cepts and user manual, page 8
1.10http://dataservice.eea.europa.eu/download.asp?id=16337&filetype=.zip
1.11http://www.epa.ie/downloads/data/corinedata/epa_corine_technical_guide_

update_2000.pdf
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2 Το Σύστηµα Γεωγραφικών Πληροφοριών
GRASS

Το GRASS-GIS2.1, 2.2 είναι ένα Σύστηµα Γεωγραφικών Πληροφοριών (ΣΓΠ) που δι-
αχειρίζεται πάσης ϕύσεως γεωχωρικά δεδοµένα. Πληροφορίες για την εγκατάσταση
του GRASS (στη Αγγλική γλώσσα) µπορούν να αναζητηθούν στον επίσηµο ιστότοπο2.3.
Για τη λήψη της τελευταίας έκδοσης του GRASS για το Ubuntu µπορούµε να ακολου-
ϑήσουµε τις οδηγίες στην ιστοσελίδα ενός µέλους της οµάδας των προγραµµατιστών του
GRASS2.4. Στο διαδίκτυο υπάρχουν πολυάριθµοι οδηγοί στην Αγγλική και σε άλλες
ξένες γλώσσες2.5, 2.6.

Για όλα τα εργαλεία που συστοιχειώνουν το GRASS υπάρχουν εγχειρί-
δια χρήσης τοπικά αποθηκευµένα, τα οποία εγκαθιστώνται µαζί µε
το λογισµικό στο σύστηµα, καθώς επίσης και στο διαδίκτυο2.7. Οι
τρόποι ανάγνωσής των παρουσιάζονται πρακτικά στις επόµενες σελίδες.
Το GRASS µπορεί να στηριχθεί σε διάφορα συστήµατα διαχείρισης
ϐάσεων δεδοµένων2.8, 2.9. Το SQLite για το οποίο γίνεται λόγος στην
επόµενη παράγραφο είναι ένα από τα υποστηριζόµενα συστήµατα2.10.

2.1 Τα βασικά χαρακτηριστικά του ΣΓΠ GRASS

Στο κεφάλαιο αυτό γίνεται µια προσπάθεια εισαγωγής στις ϐασικές έννοιες του Συστή-
µατος Γεωγραφικών Πληροφοριών GRASS. Ωστόσο, είναι προφανές ότι χωρίς πειραµα-
τισµό και πρακτική άσκηση µε το ίδιο το πρόγραµµα, η ανάγνωση του κεφαλαίου αυτού
δεν αρκεί για την ουσιαστική κατανόηση της λογικής δοµής και λειτουργίας της ϐάσης
γεωχωρικών δεδοµένων του GRASS.
2.1http://grass.osgeo.org
2.2http://grass.osgeo.org/intro/firsttime.php
2.3http://grass.osgeo.org/download/index.php
2.4Τα αποθετήρια http://www.les-ejk.cz/ubuntu επιµελείται ο Jachym Cepicky
2.5http://grass.osgeo.org/gdp/index.php
2.6http://wiki.osgeo.org/wiki/Educational_Content_Inventory
2.7http://grass.osgeo.org/gdp/manuals.php
2.8http://grass.osgeo.org/grass64/manuals/html64_user/databaseintro.html
2.9http://grass.osgeo.org/grass64/manuals/html64_user/sql.html

2.10http://grass.osgeo.org/grass64/manuals/html64_user/grass-sqlite.html

http://grass.osgeo.org
http://grass.osgeo.org/intro/firsttime.php
http://grass.osgeo.org/download/index.php
http://www.les-ejk.cz/ubuntu
http://grass.osgeo.org/gdp/index.php
http://wiki.osgeo.org/wiki/Educational_Content_Inventory
http://grass.osgeo.org/gdp/manuals.php
http://grass.osgeo.org/grass64/manuals/html64_user/databaseintro.html
http://grass.osgeo.org/grass64/manuals/html64_user/sql.html
http://grass.osgeo.org/grass64/manuals/html64_user/grass-sqlite.html


2 Το Σύστηµα Γεωγραφικών Πληροφοριών GRASS

Πριν από την περιγραφή της δοµής του GRASS επιβάλλεται µια επισήµανση για την
“κατάχρηση” του όρου ϐάση δεδοµένων από το GRASS. O όρος σηµαίνει στο GRASS:

1. Το σύνολο των γεωχωρικών δεδοµένων (ψηφιδωτοί χάρτες, διανυσµατικοί χάρτες
και πίνακες κατηγορηµάτων), των µεταδεδοµένων αυτών καθώς και των καταλόγων
/ αρχείων που προσδιορίζουν την ταξινόµηση των χαρτών και (περι-)ορίζουν γεω-
γραφικά µια περιοχή µελέτης2.11.

2. Το σύστηµα διαχείρισης των πινάκων µε τα κατηγορήµατα (attribute tables) που
αντιστοιχούν στους διανυσµατικούς χάρτες.

Αυτή η διπλή σηµασία οφείλεται στο ότι ο 1ος όρος υπάρχει πολύ πριν την λειτουργία
οποιουδήποτε συστήµατος διαχείρισης ϐάσης δεδοµένων στο GRASS2.12. Αναφορά στο
σύστηµα διαχείρισης ϐάσης δεδοµένων γίνεται στην παράγραφο 2.5.

2.2 Ο κεντρικός κατάλογος

Η ϕυσική υπόσταση της ϐάσης των γεωχωρικών δεδοµένων του GRASS είναι στην ουσία
ένας κεντρικός κατάλογος στο σύστηµα αρχείων του Η/Υ. Μέσα σε αυτόν τον κατάλογο
το GRASS αποθηκεύει ολόκληρο το υλικό (χάρτες, αρχεία) και το ταξινοµεί ανάλογα
µε τη µορφή (δεδοµένα διανυσµατικά, ψηφιδωτά, πίνακες κατηγορηµάτων κ.λπ.) σε
υποκαταλόγους. Το πρώτο ϐήµα λοιπόν για να εργαστεί κανείς µε το GRASS είναι
η δηµιουργία ενός κεντρικού καταλόγου (για παράδειγµα στην άσκηση αυτή είναι ο
κατάλογος που δηµιουργήσαµε σε προηγούµενο ϐήµα2.13.

Για κάθε αυτόνοµη εργασία (project) ο χρήστης µπορεί να δηµιουργήσει έναν ξεχωριστό
κατάλογο µέσα στον κεντρικό κατάλογο. Για παράδειγµα αν κανείς εκπονεί µια µελέτη
στην Πελοπόννησο και µια άλλη στην Θεσσαλία είναι πρακτικό να δηµιουργήσει τους
καταλόγους peloponnisos και thessalia. Μέσα σε αυτούς ϑα εργαστεί µε τις
τοποθεσίες και τις συλλογές χαρτών όπως παρουσιάζονται παρακάτω. Ο παρών οδηγός
είναι µια µικρή εφαρµογή και για το λόγο αυτό περιορίζεται στη χρήση του κεντρικού
καταλόγου µόνο.

2.11Στην ορολογία του GRASS: GRASS-GIS Database, GRASS Database, GRASSDB
2.12Το GRASS εµφανίστηκε αρχές της δεκαετίας του 80’ ως αποτέλεσµα συνεργασίας πολλών και διαφορε-

τικών, κρατικών και µη ιδρυµάτων: διαφόρων οµοσπονδιακών ιδρυµάτων των Η.Π.Α., πανεπιστηµιακών
ιδρυµάτων αλλά και ιδιωτικών εταιριών µε κύριο όµως παραγωγό του πυρήνα των λειτουργιών του και
συντονιστή της όλης προσπάθειας, το σώµα µηχανικών του Αµερικανικού στρατού USA-CERL. Ιστορικές
πληροφορίες υπάρχουν στον ιστότοπο:
http://grass.osgeo.org/devel/grasshist.html

2.13ο κατάλογος /home/user-id/grassdb δηµιουργήθηκε προφανώς κατά τη δηµιουργία της δι-
αδροµής που δηµιουργήσαµε στη παράγραφο 4
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2.3 Η έννοια της τοποθεσίας στο GRASS

Εικόνα 2.1: Παράδειγµα δοµής της ϐάσης δεδοµένων του GRASS

2.3 Η έννοια της τοποθεσίας στο GRASS

Μέσα στον κεντρικό κατάλογο και µε τη ϐοήθεια του λογισµικού, ο χρήστης πρέπει
να δηµιουργήσει µια τοποθεσία (LOCATION)2.14 ϐάσει της γεωγραφικής έκτασης της
υπό µελέτης περιοχής και το επιθυµητό προβολικό σύστηµα. Η τοποθεσία (στο GRASS)
ορίζεται από ένα και µόνο σύστηµα αναφοράς συντεταγµένων. Για το λόγο αυτό είναι
απαραίτητο να δηµιουργήσει κανείς τόσες τοποθεσίες όσες και τα διαφορετικά προβο-
λικά συστήµατα που ϑα χρησιµοποιηθούν.

Στα παραδείγµατα που ακολουθούν στα επόµενα κεφάλαια ϑα δηµιουργήσουµε τις
τοποθεσίες wgs84 και laea µε διαφορετικούς τρόπους (γραφικά στην πρώτη περίπτωση
και µε χρήση του εργαλείου g.proj στη δεύτερη περίπτωση). Η επαναπροβολή χωρικών
δεδοµένων µεταξύ των τοποθεσιών γίνεται εύκολα χρησιµοποιώντας τα εργαλεία v.proj

και r.proj (για ανυσµατικά και ψηφιδωτά δεδοµένα αντίστοιχα).

2.4 Οι συλλογές χαρτών

Για τη διευκόλυνση της συνεργασίας πολλών χρηστών στο ίδιο έργο ή για µια αποτελε-
σµατικότερη ταξινόµηση µεγάλου όγκου δεδοµένων µιας κάποιας εργασίας, το υλικό

2.14
Τοποθεσία και συλλογές χαρτών του GRASS (στην Αγγλική γλώσσα):
http://grass.osgeo.org/intro/firsttime.php#location
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2 Το Σύστηµα Γεωγραφικών Πληροφοριών GRASS

µιας τοποθεσίας, (δηλαδή οι ψηφιδωτοί, οι 3-διάστατοι και οι διανυσµατικοί χάρτες) ταξ-
ινοµείται σε συλλογές χαρτών. Μέσα δηλαδή σε µια τοποθεσία µπορούν να δηµιουργη-
ϑούν πολλές συλλογές χαρτών οι οποίες µπορούν είτε να ανήκουν σε χρήστες (ώστε κάθε
χρήστης να έχει τη δική του συλλογή) ή να εξυπηρετήσουν µια ϑεµατική ταξινόµηση του
υλικού.

Κάθε ϕορά που κάποιος χρήστης που διευθύνει κάποιο έργο δηµιουργεί µια τοπο-
ϑεσία, µια ΜΟΝΙΜΗ συλλογή χαρτών (PERMANENT Mapset) δηµιουργείται αυτόµατα
η οποία εξυπηρετεί στην αποθήκευση των “πρώτων υλών”. Από αυτή τη ΜΟΝΙΜΗ συλ-
λογή πολλαπλοί χρήστες µπορούν να αντλήσουν το υλικό τους για περαιτέρω επεξ-
εργασία στην προσωπική τους συλλογή χαρτών. Κάθε χρήστης είναι υποχρεωµένος
δηλαδή να δηµιουργήσει τη δική του συλλογή χαρτών (user mapset) και να αντιγράψει
τα δεδοµένα που τον ενδιαφέρουν από την ΜΟΝΙΜΗ συλλογή µε το εργαλείο g.copy.
Η αντιγραφή από την ΜΟΝΙΜΗ συλλογή χαρτών στην συλλογή χαρτών ενός χρήστη
δηµιουργεί εξάλλου αυτόµατα πίνακες κατηγορηµάτων στη ϐάση δεδοµένων του GRASS
για τα αντιγραµµένα διανυσµατικά δεδοµένα.

Οι χάρτες που εισάγονται στη ϐάση δεδοµένων GRASS µετατρέπονται σε συγκεκριµένη
µορφή αρχείων που µόνο το GRASS µπορεί να διαχειριστεί. Οι δυνατότητες εξαγωγής
σε κάποια άλλη µορφή2.15 την οποία µπορούν να διαχειριστούν άλλα πακέτα ΣΓΠ είναι
πάρα πολλές, τόσο για ψηφιδωτά όσο και για διανυσµατικά δεδοµένα. Συγκεκριµένα,
υποστηρίζονται όλες οι µορφές αρχείων που µπορούν και διαχειρίζονται τα εργαλεία
GDAL2.16, 2.17 και OGR2.18, 2.19.

2.5 Το σύστηµα διαχείρισης βάσης δεδοµένων SQLite

Αν και το προκαθορισµένο σύστηµα διαχείρισης ϐάσης δεδοµένων στο GRASS είναι το
DBF, στα παραδείγµατα του παρόντος οδηγού παρουσιάζεται το SQLite

2.20, 2.21, ένα
γρήγορο σύστηµα διαχείρισης2.22 SQL χωρίς υψηλές απαιτήσεις από τον Η/Υ. Είναι
απλό στη χρήση του και οι ϐάσεις που δηµιουργεί (αποθηκεύει όλα τα δεδοµένα σε
ένα αρχείο) µεταφέρονται εύκολα. Πρέπει όµως να σηµειωθεί ότι στις περιπτώσεις όπου
πολλοί χρήστες εργάζονται ταυτόχρονα σε ένα έργο µε το GRASS-GIS είναι προτιµότερη

2.15Τα εργαλεία εξαγωγής για ψηφιδωτά και διανυσµατικά δεδοµένα είναι αντίστοιχα τα r.out.* και v.out.* -

ϐλέπε παράγραφο 2.7 σχετικά µε την ονοµατολογία των εργαλείων.

2.16http://www.gdal.org
2.17http://www.gdal.org/formats_list.html
2.18http://www.gdal.org/ogr/index.html
2.19http://www.gdal.org/ogr/ogr_formats.html
2.20http://www.sqlite.org
2.21Το SQLite Είναι απαραίτητο για την λειτουργία πολλών προεγκατεστηµένων προγραµµάτων του λει-

τουργικού συστήµατος Ubuntu. Για το λόγο αυτό είναι ήδη εγκατεστηµένο µετά την ολοκλήρωση της
εγκατάστασης του Ubuntu.

2.22Στην Αγγλική γλώσσα: Data Base Management System (DBMS)
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2.6 Επιπλέον σηµαντικά χαρακτηριστικά της τοποθεσίας

η χρήση κάποιου άλλου συστήµατος διαχείρισης εξαιτίας κάποιων περιορισµών του
συστήµατος SQLite2.23.

Το sqlitebrowser
2.24, 2.25 είναι ένα εύχρηστο πρόγραµµα περιήγησης ϐάσεων δεδοµένων

SQLite. Είναι όµως προτιµότερο να γίνεται η επεξεργασία των ϐάσεων δεδοµένων µε τα
αντίστοιχα ενσωµατωµένα εργαλεία στο GRASS για να αποφεύγονται σϕάλµατα που
δηµιουργούνται από ασυµβατότητες.

2.6 Επιπλέον σηµαντικά χαρακτηριστικά της τοποθεσίας

Σηµαντικό χαρακτηριστικό της τοποθεσίας είναι η ενεργός περιοχή (computational re-
gion). Τα περισσότερα εργαλεία (που αφορούν στη διαχείριση ψηφιδωτών χαρτών) ϑα
πραγµατοποιήσουν τους υπολογισµούς τους και ϑα προβάλλουν δεδοµένα εντός της εν-
εργού περιοχής την οποία ορίζει ο χρήστης κάθε ϕορά ανάλογα µε τις ανάγκες του. Ο
ορισµός της ενεργού περιοχής υλοποιείται χρησιµοποιώντας το εργαλείο g.region από
τον ϕλοιό του GRASS. Γραφικά η ενέργεια αυτή µπορεί να εκτελεστεί µέσα από το ∆ι-

αχειριστή του ΣΓΠ (GIS-Manager)2.26 ή στο παράθυρο προβολής χαρτών (Map Display).

Στις επόµενες σελίδες παρουσιάζεται πρακτικά ο ορισµός της ενεργού περιοχής µέσα
από το ϕλοιό του GRASS καθώς και η χρήση του σχετικού µενού στο παράθυρο προβολής
των χαρτών (όχι το µενού στον ∆ιαχειριστή του ΣΓΠ ). Εκτός από την έκταση της ενεργού
περιοχής, µεγάλη σηµασία κατά την επεξεργασία ψηφιδωτών δεδοµένων έχει το µέγεθος
(γεωµετρική ανάλυση / resolution) της κάθε ψηφίδας. Οι τιµές που ορίζει ο χρήστης
για την κάθετη και οριζόντια ανάλυση της κάθε ψηφίδας προσδιορίζουν την ανάλυση
κάθε νέου ψηφιδωτού χάρτη2.27.

2.7 Η ονοµατολογία των εργαλείων του GRASS

Το ΣΓΠ GRASS είναι ουσιαστικά µια µεγάλη συλλογή2.28 από εργαλεία που διαχειρίζον-
ται γεωχωρικά δεδοµένα. Επί του παρόντος τα εργαλεία της ϐασικής εγκατάστασης είναι
πάνω από 400. Η ονοµατολογία των εργαλείων σχετίζεται µε τις κατηγορίες χωρικών

2.23Σύντοµες απαντήσεις σε συχνά ερωτήµατα: http://www.sqlite.org/faq.html
2.24http://sourceforge.net/projects/sqlitebrowser
2.25Για το Ubuntu (εκδόσεις Ubuntu-Linux 8.04, 8.10) το πρόγραµµα sqlitebrowser είναι διαθέσιµο στα

αποθετήρια
2.26http://grass.osgeo.org/grass63/manuals/html63_user/gis.m.html
2.27Επειδή ο παρών οδηγός δεν ασχολείται ουσιαστικά µε ψηφιδωτά δεδοµένα, δεν παρουσιάζεται η σηµασία

και η χρήση της ανάλυσης των ψηφίδων που, εικονικά, καλύπτουν την ενεργό περιοχή µιας τοπο-
ϑεσίας στο GRASS. Περισσότερες πληροφορίες επ’ αυτού υπάρχουν στο εγχειρίδιο χρήσης του εργαλείου
g.region.

2.28http://grass.osgeo.org/grass63/manuals/html63_user/full_index.html
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δεδοµένων ή άλλες γενικές ή ειδικές εργασίες. Συγκεκριµένα, το όνοµα κάθε εργαλείου
έχει ως πρώτο χαρακτήρα, ακολουθούµενο από µια τελεία, το πρώτο γράµµα του αγ-
γλικού λήµµατος που χαρακτηρίζει την γενική κατηγορία χωρικών δεδοµένων που δι-
αχειρίζεται το εργαλείο αυτό ή της γενικής/ειδικής κατηγορίας εργασιών στην οποία
ανήκει.

Μερικά παραδείγµατα για τις πιο σηµαντικές κατηγορίες: το εργαλείο v.patch ανήκει
στην κατηγορία εργαλείων που διαχειρίζονται διανυσµατικά δεδοµένα (από το vector).
Το εργαλείο g.region σχετίζεται µε την διαχείριση των χαρακτηριστικών της τοποθεσίας
και ανήκει στην γενική κατηγορία εργαλείων (generic). Εργαλεία που διαχειρίζονται
ψηφιδωτά δεδοµένα ξεκινούν µε το r. (από το raster) και µε d. (από το display) ξεκινούν
τα εργαλεία σχετικά µε την προβολή/απεικόνιση δεδοµένων. Με db. (από το database)
ονοµάζονται τα εργαλεία διαχείριση της ϐάσης δεδοµένων (πίνακες κατηγορηµάτων)
και µε i. (από το imagery) τα εργαλεία επεξεργασίας και ανάλυσης ψηφιακών εικόνων
(ψηφιδωτά δεδοµένα επίσης).



Μέρος II

Αναπαραγωγή του χάρτη CORINE για την
Πελοπόννησο
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Με µια µατιά...

• Βήµα 1ο

◦ Λήψη ακτογραµµής από την διαδικτυακή υπηρεσία του Οργανισµού NOAA
coastline extractor

◦ ∆ηµιουργία τοποθεσίας (LOCATION) στο GRASS ϐάσει του datum WGS84
και εισαγωγή της ακτογραµµής στην ϐάση δεδοµένων

• Βήµα 2ο

◦ Επεξεργασία της ακτογραµµής για τη δηµιουργία ενός χάρτη-µάσκας που
καλύπτει την υπό µελέτη περιοχή

• Βήµα 3ο

◦ Λήψη πλακιδίων από τον ευρωπαϊκό χάρτη CORINE

◦ ∆ηµιουργία τοποθεσίας (LOCATION) ϐάσει του ETRS892.29 και εισαγωγή των
πλακιδίων CORINE

• Βήµα 4ο

◦ ΄Ενωση των πλακιδίων για τον σχηµατισµό ενός χάρτη

◦ Συγχώνευση γειτονικών γεωµετριών ϐάσει κοινού κωδικού κάλυψης/χρήσης
γης για την απαλοιφή τοπολογικών σϕαλµάτων

• Βήµα 5ο

◦ Απόδοση της επίσηµης χρωµατικής κωδικοποίησης στον τελικό χάρτη CORINE
και εκτίµησης εµβαδού ανά κατηγορία CORINE

2.29European Terrestrial Reference System 89





3 Λήψη και εισαγωγή της ακτογραµµής στη
βάση δεδοµένων

Στο παράδειγµά µας κάνουµε χρήση της διαδικτυακής υπηρεσίας Coastline Extractor
3.1

που προσϕέρει ο οργανισµός NOAA3.2 απ’ όπου και λαµβάνουµε την ακτογραµµή της
Πελοποννήσου για να ορίσουµε γεωγραφικά την υπό µελέτη περιοχή µας. Με λίγο
πειραµατισµό ϐρίσκουµε τις γεωγραφικές συντεταγµένες3.3 που περικλείουν ολόκληρη
την Πελοπόννησο. Αυτές είναι: (Ανατολικά) East=23.6, (Βόρεια) North=38.5, (∆υτικά)
West=21, (Νότια) South=36 (εικόνα (3.1)).

Πλοηγούµαστε στον ιστότοπο Coastline Extractor και εισάγουµε τις γεωγραφικές συν-
τεταγµένες στα αντίστοιχα πεδία κάτω από τον τίτλο Geographic Range of Coastline to

Extract
3.4. Σιγουρευόµαστε ότι το αρχείο µορφής Mapgen είναι επιλεγµένο κάτω από

τον τίτλο Coast Format options και επιλέγουµε µε το ποντίκι το πεδίο SUBMIT – Extract
the Coastline File (ή απλά πιέζουµε το πλήκτρο Enter ενόσω ο δροµέας ϐρίσκεται µέσα
σε ένα από τα πεδία εισαγωγής συντεταγµένων). Κάτω από το χάρτη που ϑα προβληθεί,
υπάρχει ένας σύνδεσµος προς ένα αρχείο dat (π.χ. 8145.dat) το οποίο περιέχει την
Ϲητούµενη ακτογραµµή. Επιλέγουµε το σύνδεσµο µε το ποντίκι και αποθηκεύουµε το
αρχείο τοπικά, για παράδειγµα µέσα στον κατάλογο /home/user−id/grassdb/clc2000
.

Εκκινούµε το γραφικό περιβάλλον του GRASS εκτελώντας την ακόλουθη εντολή µέσα
από ένα τερµατικό:

$ grass -gui

Στο παράθυρο εκκίνησης του GRASS επιλέγουµε EPSG Codes. Θα εµφανιστεί το
παράθυρο ορισµού µιας τοποθεσίας ϐάσει κωδικού EPSG (εικόνα 3.2) µε τη ϐοήθεια
του οποίου δηµιουργούµε µια τοποθεσία ορισµένη από το datum WGS843.5 (στο οποίο
είναι προβεβληµένη η ακτογραµµή) χρησιµοποιώντας τον κωδικό EPSG 43263.6.
3.1http://rimmer.ngdc.noaa.gov/mgg/coast/getcoast.html
3.2http://www.noaa.gov
3.3σε δεκαδικές µοίρες
3.4Η ακτογραµµή µπορεί να αποθηκευτεί ως αρχείο mapgen (προβεβληµένη στο γεωγραφικό σύστηµα

συντεταγµένων WGS84 και να εισαχθεί στη ϐάση δεδοµένων του GRASS µε το εργαλείο v.in.mapgen.
3.5http://en.wikipedia.org/wiki/WGS84
3.6http://spatialreference.org/ref/epsg/4326

http://rimmer.ngdc.noaa.gov/mgg/coast/getcoast.html
http://www.noaa.gov
http://en.wikipedia.org/wiki/WGS84
http://spatialreference.org/ref/epsg/4326


3 Λήψη και εισαγωγή της ακτογραµµής στη ϐάση δεδοµένων

Εικόνα 3.1: Γεωγραφικά όρια της Πελοποννήσου

Εικόνα 3.2: Ορισµός τοποθεσίας ϐάσει κωδικού EPSG

Πληκτρολογούµε ένα όνοµα (π.χ. wgs84) και τον κωδικό 4326 στα αντίστοιχα πεδία και
επιλέγουµε Define location. Μια νέα ΜΟΝΙΜΗ συλλογή χαρτών (PERMANENT Mapset)
ϑα δηµιουργηθεί µε την οποία και ϑα εργαστούµε σε όλα τα επόµενα ϐήµατα.

΄Επειτα επιλέγουµε Enter GRASS. Θα εµφανιστούν τρία παράθυρα εργασίας: το κυρίως
παράθυρο ∆ιαχειριστής του ΣΓΠ

3.7 (εικόνα 3.3 και εικόνα 3.5), το παράθυρο εξόδου
µηνυµάτων σχετικών µε τις πάσης ϕύσεως εκτελούµενες εργασίες Output window

3.8

και το παράθυρο προβολής των χαρτών (εικόνα 3.7).

3.7http://grass.osgeo.org/grass63/manuals/html63_user/gis.m.html
3.8Στο νέο γραφικό περιβάλλον του GRASS, το παράθυρο εξόδου µηνυµάτων είναι ενσωµατωµένο στον

∆ιαχειριστή του ΣΓΠ. Περισσότερες πληροφορίες στον ιστότοπο:
http://grass.osgeo.org/wiki/WxPython-based_GUI_for_GRASS

30

http://grass.osgeo.org/grass63/manuals/html63_user/gis.m.html
 http://grass.osgeo.org/wiki/WxPython-based_GUI_for_GRASS


Μπορούµε να αναγνώσουµε τα κείµενα ϐοήθειας σε έναν ϕυλλοµετρητή διαδικτύου
επιλέγοντας Help > GRASS Help. Για παράδειγµα αναζητούµε πληροφορίες για το
εργαλείο v.in.mapgen, το οποίο και ϑα χρησιµοποιήσουµε για την εισαγωγή της ακ-
τογραµµής στη ϐάση δεδοµένων: επιλέγουµε το σύνδεσµο vector commands έπειτα
εντοπίζουµε και επιλέγουµε το σύνδεσµο v.in.mapgen.

Εικόνα 3.3: Εισαγωγή αρχείων Mapgen (α)

Χρησιµοποιώντας τον ∆ιαχειριστή του ΣΓΠ εισαγάγουµε την ακτογραµµή στη ϐάση δε-
δοµένων (εικόνα 3.3): File > Import Vector map > Matlab and Mapgen > επιλέγουµε
το πλήκτρο κίτρινος ϕάκελος (εικόνα 3.4) και πλοηγούµαστε στον κατάλογο όπου απο-
ϑηκεύσαµε το αρχείο dat, πληκτρολογούµε ένα όνοµα για το εισηγµένο αρχείο και
επιλέγουµε Run µε το ποντίκι.

Μετά την εισαγωγή στη ϐάση δεδοµένων, η ακτογραµµή µπορεί να προβληθεί ως εξής:

1. Προσϑέτουµε ένα επίπεδο διανυσµατικού χάρτη στον ∆ιαχειριστή του ΣΓΠ (εικόνα
3.5)

31



3 Λήψη και εισαγωγή της ακτογραµµής στη ϐάση δεδοµένων

Εικόνα 3.4: Εισαγωγή αρχείων Mapgen (ϐ)

2. Ενεργοποιούµε το διάλογο ϕόρτωσης διανυσµατικού χάρτη για το επιλεγµένο
επίπεδο (εικόνα 3.5)

3. Φορτώνουµε σε αυτό το επίπεδο το αρχείο coastlines (εικόνα 3.6).

4. Προβάλλουµε το διανυσµατικό χάρτη στο παράθυρο προβολής χαρτών (εικόνα
3.7).

5. ΄Επειτα προβάλλουµε στο µέγιστο δυνατό, µέσα στο παράθυρο προβολής, το χάρτη
που είναι ϕορτωµένος στο επιλεγµένο επίπεδο του ∆ιαχειριστή του ΣΓΠ επιλέ-
γοντας Zoom display to selected map.

6. Μπορούµε να ταυτίσουµε επιπλέον την ενεργό περιοχή µε τη γεωγραφική έκταση
που ϐλέπουµε στο παράθυρο προβολής επιλέγοντας το set the computational re-

gion extent to match the display. Η ενεργός περιοχή περιορίζει την έκταση όλων
των δεδοµένων που µπορούν να προβληθούν στο παράθυρο προβολής, περιορίζει
την ισχύ των εργαλείων επεξεργασίας ψηφιδωτών χαρτών µέσα σε αυτή χωρίς όµως
ωστόσο να επηρεάζει την όποια επεξεργασία διανυσµατικών χαρτών.

Το επόµενο ϐήµα είναι η µετατροπή των γραµµών σε όρια: Vector > Develop > Convert
object types (η ενέργεια αυτή ενεργοποιεί το διάλογο του σεναρίου v.type.sh, εικόνα
3.8).

Τα όρια coastlines χρήζουν κάποιας επεξεργασίας ώστε να αποµονωθεί η χερ-
σόνησος και να διαγραφούν οι υπόλοιπες γραµµές πάνω από την Πελοπόννησο. Χρησι-
µοποιούµε το εργαλείο v.digit για την επεξεργασία. Vector > Develop > Digitize, επιλέ-
γουµε το αρχείο coastlines_bndrs προς επεξεργασία (εικόνα 3.9) και έπειτα Run.
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Εικόνα 3.5: Προβολή διανυσµατικού χάρτη µε τον ∆ιαχειριστή του ΣΓΠ
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3 Λήψη και εισαγωγή της ακτογραµµής στη ϐάση δεδοµένων

Εικόνα 3.6: ∆ιάλογος ϕόρτωσης διανυσµατικού χάρτη

Εικόνα 3.7: Το παράθυρο προβολής
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Εικόνα 3.8: Ο γραφικός διάλογο του σεναρίου v.type.sh

Εικόνα 3.9: Ο διάλογος εκκίνησης του εργαλείου v.digit

Οι εργασίες ψηφιοποίησης/επεξεργασίας στο GRASS είναι εύκολες όταν ο χρήστης
εξοικειωθεί µε τα πλήκτρα-ενέργειες του ποντικιού και τα εργαλεία επεξεργασίας. Οι
ενέργειες κάθε πλήκτρου εξηγούνται µετά την επιλογή κάποιου εργαλείου στο παράθυρο
v.digit.

Στην περίπτωσή µας πρέπει να τµήσουµε τα όρια της ακτογραµµής σε δυο σηµεία, να
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3 Λήψη και εισαγωγή της ακτογραµµής στη ϐάση δεδοµένων

Εικόνα 3.10: Το γραφικό µενού του v.digit

επεξεργαστούµε τα όρια ώστε να κλείσουµε την χερσόνησο και να διαγράψουµε τις υπό-
λοιπες γραµµές και τα κεντροειδή σηµεία (boundaries and centroids) έξω το πολύγωνο
που µας ενδιαφέρει, δηλαδή την Πελοπόννησο.

Εικόνα 3.11: Επεξεργασία της ακτογραµµής

�

�

�

�

• Τα πλήκτρα 1,2 και 3 στην εικόνα 3.10, αντιστοιχούν στις ενέργειες τµήση, επεξ-
εργασία και διαγραφή αντίστοιχα.

• Στην εικόνα 3.11, από δεξιά προς αριστερά: τµήση σε 2 σηµεία, σύνδεση (κλείσιµο)
των ορίων, διαγραφή όλων των αχρείαστων ορίων

Αυτό που είναι ασυνήθιστο είναι η έλλειψη της λειτουργίας της αναστροφής (undo) των
ενεργειών. Η λειτουργία αυτή υφίσταται στο νέο γραφικό περιβάλλον wxGRASS το
οποίο είναι υπό κατασκευή. Οι αλλαγές µετά την όποια επεξεργασία ϑα υλοποιηθούν
µόνο µετά την επιλογή του πλήκτρου save & exit (πάνω δεξιά γωνία).

Το GRASS αναγνωρίζει ως κλειστή επιφάνεια3.9 τον συνδυασµό ενός κλειστού ορίου
(πολυγώνου) και ενός περιεχόµενου σε αυτό κεντροειδές σηµείο. Γι’ αυτό το λόγο είναι
3.9areas:

http://www.ing.unitn.it/~grass/conferences/GRASS2002/proceedings/
proceedings/pdfs/Blazek_Radim.pdf
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απαραίτητο να προσϑέσουµε κεντροειδή σηµεία σε όλα τα κλειστά όρια (πολύγωνα).
Στο ∆ιαχειριστή του ΣΓΠ επιλέγουµε Vector > Develop > Add centroids. Στο παράθυρο
του εργαλείου v.centroids επιλέγουµε ως πηγή3.10 το αρχείο coastlines_bndrs και
πληκτρολογούµε στο πεδίο ονόµατος εξόδου3.11 ένα όνοµα για το νέο αρχείο που ϑα
δηµιουργηθεί (π.χ. studyarea).

Προσϑέτουµε ένα ακόµη επίπεδο ανυσµατικών δεδοµένων στον ∆ιαχειριστή του ΣΓΠ,
ϕορτώνουµε το αρχείο studyarea και ανανεώνουµε το περιεχόµενο στο παράθυρο προβο-
λής χαρτών (εικόνα 3.12).

Εικόνα 3.12: Ανανέωση του παραθύρου προβολής

3.10input vector map
3.11output name field
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4 Λήψη των πλακιδίων CORINE

Στο παράδειγµά µας χρησιµοποιούµε 8 πλακίδια που καλύπτουν την Πελοπόννησο.
Συγκεντρώνουµε τα ληφθέντα συµπιεσµένα αρχεία zip σε έναν κατάλογο. Ανοίγουµε
ένα τερµατικό και µε µια εντολή δηµιουργούµε έναν υποκατάλογο (τον ονοµάζουµε
για παράδειγµα tiles) µέσα σε έναν κεντρικό κατάλογο στον οποίο ϑα αποθηκευτεί
η ϐάση γεωχωρικών δεδοµένων του GRASS (ονοµάζουµε τον κεντρικό κατάλογο για
παράδειγµα grassdb).

Πλοηγούµαστε για παράδειγµα στον δικό µας κατάλογο4.1

$ cd /home/user-id

∆ηµιουργούµε τους καταλόγους µε τα απαραίτητα δικαιώµατα ανάγνωσης - εγγραφής
- εκτέλεσης4.2

$ mkdir -p grassdb/clc2000/tiles
$ sudo chmod ug+rwx -R grassdb

Τοποθετούµε τα ληφθέντα αρχεία στο νέο κατάλογο4.3

$ mv /from/your/download/directory/100km*.zip /home/
user-id/grassdb/clc2000/tiles

΄Επειτα πλοηγούµαστε στον κατάλογο που περιέχει τα πλακίδια και τα αποσυµπιέζουµε
όλα µε µια εντολή

$ cd /home/user-id/grassdb/clc2000/tiles
$ unzip \*.zip

4.1http://tldp.org/LDP/Linux-Filesystem-Hierarchy/html/home.html
4.2Το τελευταίο ϐήµα µπορεί να εκτελεστεί και µε τη χρήση του γραφικού περιβάλλοντος. Αναζητήστε

πληροφορίες περί Changing Permissions στο Κέντρο Βοήθειας του Ubuntu πατώντας F1
4.3Αντικαθιστούµε το κείµενο /from/your/download/directory/ µε τον πραγµατικό κατάλογο στον

οποίο έχουµε αποθηκεύσει τα ληφθέντα αρχεία

http://tldp.org/LDP/Linux-Filesystem-Hierarchy/html/home.html


4 Λήψη των πλακιδίων CORINE

Εικόνα 4.1: Η διαδικτυακή υπηρεσία λήψης πλακιδίων CORINE

Οι επιµέρους διανυσµατικοί χάρτες-πλακίδια πρέπει να ενωθούν ώστε να σχηµατισ-
τεί ένας ενιαίος χάρτης. Ο οδηγός παρουσιάζει τη σχετική µέθοδο µε τα εργαλεία
του GRASS. Για τη συνένωση διανυσµατικών δεδοµένων υπό µορφή αρχείων Shape-

files µε τη χρήση εργαλείων OGR ϐλέπε: Οδηγός αξιοποίησης της ϐάσης δεδοµένων

CORINE2000 µε το GRASS-GIS υπό το Ubuntu-Linux 8.04 (κεφάλαιο 5ο) που δηµοσιεύτη-
κε στο blog Tήλαφος (Μάιος 2008).
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5 ∆ηµιουργία τοποθεσίας βάσει του συστήµατος
συντεταγµένων ETRS89

Χρησιµοποιώντας το ogrinfo µπορούµε να διαβάσουµε τα περιεχόµενα ενός από τα
πλακίδια CORINE για να µάθουµε σε ποιο σύστηµα αναφοράς συντεταγµένων είναι
προβεβληµένος ο χάρτης κάλυψης/χρήσης γης CORINE.

Μέσα από τον ϕλοιό του GRASS ή από ένα τερµατικό πλοηγούµαστε στον κατάλογο
όπου και είναι αποθηκευµένα τα shapefiles και προβάλουµε τις πρώτες 20 γραµµές
ενός από τα πλακίδια:

$ ogrinfo 100KME53N16.shp -al | head -20

INFO: Open of ‘100KME53N16.shp’
using driver ‘ESRI Shapefile’ successful.
Layer name: 100KME53N16
Geometry: Polygon
Feature Count: 1743
Extent: (5321431.203205, 1599999.999553) -

(5400000.000207, 1699999.999646)
Layer SRS WKT:
PROJCS["ETRS_1989_LAEA",
GEOGCS["GCS_ETRS_1989",
DATUM["European_Terrestrial_Reference_System_1989",
SPHEROID["GRS_1980",6378137.0,298.257222101]],
PRIMEM["Greenwich",0.0],
UNIT["Degree",0.0174532925199433]],
PROJECTION["Lambert_Azimuthal_Equal_Area"],
PARAMETER["False_Easting",4321000.0],
PARAMETER["False_Northing",3210000.0],
PARAMETER["Central_Meridian",10.0],
PARAMETER["Latitude_Of_Origin",52.0],
UNIT["Meter",1.0]]

Μπορούµε να χρησιµοποιήσουµε την πληροφορία αυτή άµεσα για την δηµιουργία µιας
τοποθεσίας και να την τιτλοφορήσουµε µε ϐάση το όνοµα του προβολικού συστήµατος



5 ∆ηµιουργία τοποθεσίας ϐάσει του συστήµατος συντεταγµένων ETRS89

(LAEA). Φυσικά µπορεί να χρησιµοποιηθεί οποιοδήποτε άλλο όνοµα όπως ϕερ’ ειπείν
το όνοµα του datum το οποίο είναι το ETRS895.1.

Ο λόγος είναι ότι το Linux διαχειρίζεται µε ακρίβεια τους χαρακτήρες (µικρά έναντι κε-
ϕαλαία). Για παράδειγµα το etrs98 λαµβάνεται ως διαφορετικό όνοµα από το Etrs89.

Εκκινούµε το GRASS και εισερχόµαστε στην τοποθεσία wgs84. Υποθέτοντας ότι δεν
γνωϱίζουµε τίποτα για το εργαλείο g.proj το οποίο είναι ιδιαίτερα χρήσιµο στην συγ-
κεκριµένα περίσταση, πληκτρολογούµε g.proj help ή g.proj corine. Το µήνυµα
εξόδου είναι ό,τι χρειαζόµαστε για την ορθή χρήση του g.proj (στην 2η περίπτωση το
GRASS ϑα παραπονεθεί επιπλέον για την άγνωστη παράµετρο corine).

Για να δηµιουργήσουµε λοιπόν µια νέα τοποθεσία ϐασισµένη στο προβολικό σύστηµα
ενός από τα ήδη γεωαναφερµένα πλακίδια CORINE εκτελούµε την ακόλουθη εντολή
στο ϕλοιό του GRASS

> g.proj -c georef=/home/user-id/grassdb/clc2000/
tiles/100KME53N16.shp location=laea

Trying to open with OGR...
...succeeded.
Location laea created!

Είναι σηµαντικό να εξέλθουµε από τη συνεδρία του GRASS εκτελώντας την εντολή exit
στο ϕλοιό του. Αν απλά ϑέλουµε να κλείσουµε τα παράθυρα του γραφικού περιβάλλον-
τος επιλέγουµε το πλήκτρο X που ϐρίσκεται (συνήθως) στην πάνω δεξιά γωνία σε κάθε
παράθυρο ή επιλέγουµε File > Exit στον ∆ιαχειριστή του ΣΓΠ ή πιέζουµε το συνδυασµό
Ctrl+Q στο πληκτρολόγιο.

5.1Συγκεκριµένα πρόκειται για το ETRS89/ ETRS-LAEA (European Terrestrial Reference System 89,
Lambert Azimuthal Equal Area): http://spatialreference.org/ref/epsg/3035/
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6 Εισαγωγή των πλακιδίων CORINE στη βάση
δεδοµένων

Εκκινούµε το GRASS και εισερχόµαστε στην τοποθεσία laea στη ΜΟΝΙΜΗ συλλογή
χαρτών. Πρώτα ϑα πρέπει να δηµιουργηθεί η σύνδεση της ϐάσης δεδοµένων των δι-
ανυσµατικών χαρτών µε τη ϐάση δεδοµένων των πινάκων µε τα κατηγορήµατα µέσω
ενός συστήµατος διαχείρισης ϐάσεων δεδοµένων (στην άσκηση αυτή χρησιµοποιούµε το
σύστηµα sqlite για το οποίο έγινε και λόγος στο πρώτο κεφάλαιο).

> db.connect driver=sqlite database=/home/user-id/
grassdb/clc2000/laea/PERMANENT/sqlite.db

driver:sqlite
database:/home/nik/grassdb/peloponnese/hgrs87/

PERMANENT/sqlite.db
schema:
group:

(Επανα-)Προβάλλουµε στην τρέχουσα τοποθεσία το αρχείο studyarea από την τοπο-
ϑεσία wgs84 και ταυτίζουµε την ενεργό γεωγραφική έκταση µε την έκταση του αρχείου
studyarea.

> v.proj studyarea location=wgs84
> g.region vect=studyarea -p

Για την εισαγωγή όλων των πλακιδίων CORINE σε ένα ϐήµα δηµιουργούµε ένα σενάριο.
Είναι σηµαντικό να γνωρίζουµε ότι τα ανυσµατικά αρχεία στην ϐάση γεωγραφικών δε-
δοµένων του GRASS δεν επιδέχονται6.1:

• αριθµούς ως πρώτο χαρακτήρα του ονόµατος

• την παρουσία . (τελείας) οπουδήποτε µέσα στο όνοµα.
6.1http://grass.itc.it/grass62/manuals/html62_user/sql.html
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6 Εισαγωγή των πλακιδίων CORINE στη ϐάση δεδοµένων

Για να µετονοµάσουµε τα shapefiles, των οποίων τα ονόµατα έχουν ως πρώτο χαρακτήρα
έναν αριθµό, χρησιµοποιούµε κάποιες εντολές *nix6.2 κατά την ανάγνωσή τους από
το εργαλείο v.in.ogr ώστε να αποφύγουµε την µετονοµασία καθενός από τα αρχεία-
πλακίδια χωριστά. Μέσα από το ϕλοιό του GRASS πλοηγούµαστε στον κατάλογο µε τα
shapefiles

> cd /home/user-id/clc2000/tiles

και χρησιµοποιούµε έναν επεξεργαστή κειµένου (στην προκειµένη το πρόγραµµα nano)
για να δηµιουργήσουµε ένα σενάριο µε το όνοµα import_clc2000_tiles.sh

> nano import_clc2000_tiles.sh

Γράφουµε τις απαραίτητες εντολές

#! /bin/bash
for i in *.shp; do
v.in.ogr -r dsn=$i out=x‘echo $i | sed ’s+\.+_+g’‘
done

Αποθηκεύουµε και εξερχόµαστε από τον επεξεργαστή nano µε Ctrl+X (απαντούµε µε
Y και πιέζουµε το Enter).'

&

$

%

• Το σενάριο αυτό ϑα διαβάσει µε τη σειρά όλα τα αρχεία µε την κατάληξη .shp στον
τρέχοντα υποκατάλογο τροφοδοτώντας κάθε ϕορά την παράµετρο dsn=.

• Προφανώς ϑα εκτελεστεί µε επιτυχία µόνο αν κληθεί µέσα από τον υποκατάλογο
στον οποίο είναι αποθηκευµένα τα shapefiles.

• Η παράµετρος out= ϑα δεχτεί ονόµατα µε ένα x ως πρώτο χαρακτήρα ακολου-
ϑούµενο από το αποτέλεσµα της εντολής echo $i | sed ’s+\.+_+g’.

• Η παρουσία της κατακορύφου γραµµής | στο τέλος της εντολής echo $i ϑα
διοχετεύσει το αποτέλεσµά της στην εντολή sed ’s+\.+_+g’ ϐάσει της οποίας
όλες οι τελείες . ϑα µετατραπούν σε κάτω παύλες _.

Σιγουρευόµαστε ότι το αρχείο-σενάριο έχει τα σωστά δικαιώµατα ανάγνωσης-εγγραφής-

εκτέλεσης και το εκτελούµε

> sudo chmod ug+rx import_clc2000_tiles.sh
> sh import_clc2000_tiles.sh

6.2http://en.wikipedia.org/wiki/Unix-like
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7 ΄Ενωση των πλακιδίων σε ένα χάρτη

Μπορούµε να ενώσουµε όλα τα πλακίδια CORINE σε ένα χάρτη µε το εργαλείο v.patch.
Πρώτα πρέπει να σιγουρευτούµε ότι οι πίνακες κατηγορηµάτων όλων των πλακιδίων
ταυτίζονται ως προς τη δοµή τους για να είναι εφικτή η ένωσή τους. Ειδάλλως το
GRASS ϑα παραπονεθεί ότι τα πλακίδια έχουν διαφορετικούς πίνακες κατηγορηµάτων.

Ελέγχουµε έναν προς ένα όλους τους πίνακες κατηγορηµάτων των πλακιδίων και δια-
γράφουµε τις µη κοινές στήλες (π.χ. τις SHAPE_area, AREA, AREA_HA, κ.λπ.) χρησι-
µοποιώντας το εργαλείο v.db.dropcol ή το πρόγραµµα sqlitebrowser. Στο παράδειγµά
µας χρησιµοποιούµε το sqlitebrowser για να επεξεργαστούµε τη ϐάση δεδοµένων η
οποία είναι ουσιαστικά το αρχείο sqlite.db

> sqlitebrowser /home/user-id/grassdb/laea/PERMANENT/
sqlite.db

Αρχικά µπορούµε να δούµε τη δοµή των πινάκων µε τα κατηγορήµατα για κάθε πλακί-
διο στην πρώτη καρτέλα (Database Structure). ∆ιαπιστώνουµε ότι υπάρχουν διαφορές.
Επιλέγουµε από το µενού Edit > Modify Table > στο πεδίο Table name επιλέγουµε
ένα πλακίδιο, π.χ. το x100KME53N16_shp > Edit > επιλέγουµε το κατηγόρηµα AREA
> το διαγράφουµε επιλέγοντας Remove field > Yes > Close. Επαναλαµβάνουµε για
όλα τα πλακίδια διατηρώντας τελικά µόνο τα κατηγορήµατα (στήλες) cat και CODE_00.
Αποθηκεύουµε τις αλλαγές και εξερχόµαστε επιλέγοντας File > Save Database > Exit

Τώρα µπορούµε να ενώσουµε όλα τα πλακίδια σε ένα χάρτη (εικόνα 7.1) µε ένα µόνο
ϐήµα χρησιµοποιώντας το εργαλείο g.mlist (περισσότερες πληροφορίες για το εργαλείο
g.mlist και την χρήση του πληκτρολογώντας man g.mlist ή g.manual g.mlist)

> v.patch -e input=‘g.mlist vect sep=, pattern=x100*‘
out=corine

[...]
v.patch complete. 8 vector maps patched

Μπορούµε να επιβεβαιώσουµε ότι ο πίνακας κατηγορηµάτων του χάρτη corine έχει
προστεθεί στη ϐάση γεωγραφικών δεδοµένων



7 ΄Ενωση των πλακιδίων σε ένα χάρτη

Εικόνα 7.1: O χάρτης µετά τη ένωση των πλακιδίων

> db.tables -p

[...]

Για λόγους που ϑα δούµε στο επόµενο κεφάλαιο µετατρέπουµε τον τύπο του κατη-
γορήµατος CODE_00 από κείµενο (text) σε ακέραιο αριθµό (integer). Πρόκειται για
σηµαντική λεπτοµέρεια που, αν αγνοηθεί, µπορεί να κουράσει το χρήστη :-)7.1.
Εκκινούµε ξανά το sqlitebrowser και επιλέγουµε Edit > Modify Table > επιλέγουµε
corine > Edit > επιλέγουµε το κατηγόρηµα CODE_00 > Edit field > επιλέγουµε το
πλήκτρο µε τις τρεις τελείες ... (custom type) > πληκτρολογούµε integer > OK >
Apply Changes > Close > File > Exit

Το ιστορικό της επεξεργασίας ενός χάρτη µπορεί να αναγνωσϑεί µε το εργαλείο v.info.

> v.info -h corine

COMMAND: v.patch -e input="x100KME53N16_shp,
x100KME53N17_shp,x100KME54N15_shp,x100KME54N16_shp
,x100KME54N17_shp,x100KME55N15_shp,
x100KME55N16_shp,x100KME55N17_shp" output="corine"

7.1∆ιάβαζε σχετική συζήτηση στο αρχείο λίστας GRASS-user http://lists.osgeo.org/pipermail/
grass-user/2008-January/042726.html
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Εικόνα 7.2: Ο περιηγητής SQLite Database Browser

GISDBASE: /home/nik/grassdb/clc2000
LOCATION: laea MAPSET: PERMANENT USER: nik DATE: Sun

Mar 16 23:44:15 2008

Παρατηρούµε ότι στο ιστορικό, στην παράµετρο input= η εντολή g.mlist vect
sep=, pattern=x100* έχει αντικατασταθεί από το αποτέλεσµά της. Mπορούµε
επίσης να προσθέσουµε την εντολή ως έχει στα µεταδεδοµένα του χάρτη µε το εργαλείο
v.support. Για να αποτρέψουµε την εκτέλεση της εντολής πρέπει να απορρίψουµε πριν
και µετά από την εντολή τους χαρακτήρες ‘ (πλάγιος τόνος, ϐρίσκεται συνήθως στο
πάνω αριστερό µέρος του πληκτρολογίου) οι οποίοι “ευθύνονται” για την εκτέλεσή της.
Για παράδειγµα:

> v.support map=corine map_name="CORINE land cover
2000" comment="command g.mlist vect sep=, pattern=
x100* used for v.patch input, map needs cleaning
and dissolving"

Το ιστορικό είναι ιδιαίτερα χρήσιµο ιδιαίτερα όταν ϑέλει κανείς να περιγράψει µε
λεπτοµέρεια τα ϐήµατα επεξεργασίας των δεδοµένων που ακολούθησε. ΄Οπως για
παράδειγµα σε αυτόν τον οδηγό :-).
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8 Συγχώνευση γειτονικών γεωµετριών βάσει
κατηγορήµατος

Εικόνα 8.1: Σε έµφαση τα όρια των πλακιδίων µετά την ένωσή τους



8 Συγχώνευση γειτονικών γεωµετριών ϐάσει κατηγορήµατος

Με την προβολή του νέου χάρτη (εικόνα 7.1) ανακαλύπτει κανείς ότι έχουν διατηρηθεί
τα όρια των πλακιδίων (κάθετες και οριζόντιες γραµµές - εικόνα 8.1). Είναι απαραίτητο
να συγχωνευθούν τα γειτονικά πολύγωνα που έχουν χωριστεί από τα όρια των πλακιδίων
ϐάσει του κοινού κωδικού τους που αντιστοιχεί στην κατηγορία κάλυψης/χρήσης γης.

Το πρώτο ϐήµα είναι να ελέγξουµε την τοπολογία του νέου χάρτη και διορθώσουµε
πιθανά λάθη (περισσότερες πληροφορίες στην Αγγλική γλώσσα στο εγχειρίδιο χρήσης
του εργαλείου συγχώνευσης γειτονικών γεωµετριών v.dissolve):

> v.clean input=corine output=corine_clean type=point
,line,boundary,centroid,area tool=snap,break,
rmdupl thresh=.01

Η συγχώνευση υλοποιείται µε την εξής εντολή

> v.dissolve input=corine_clean output=
corine_dissolved col=CODE_00

Το αποτέλεσµα της συγχώνευσης µπορεί να επιβεβαιωθεί µε την οπτική εξέταση του
νέου διανυσµατικού χάρτη corine_dissolved. Στη συνέχεια υπερθέτουµε τα όρια
studyarea στον χάρτη clc2000_final ώστε να κρατήσουµε µόνο την επιφάνεια
που καλύπτει την υπό µελέτη περιοχή µας

> v.overlay ainput=studyarea atype=area binput=
corine_dissolved btype=area output=
corine_studyarea operator=and olayer=1,0,0

Μπορούµε να εµφανίσουµε τη δοµή του πίνακα κατηγορηµάτων του νέου χάρτη µε την
εντολή

> db.describe -c corine_studyarea

[...]

Οι στήλες που µας ενδιαφέρουν στον νέο χάρτη είναι οι cat, a_b_nam και b_cat. Χρησι-
µοποιούµε ξανά το πρόγραµµα sqlitebrowser για να µετονοµάσουµε την a_b_nam σε
name και την b_cat σε code. ∆ιαγράφουµε τις υπόλοιπες στήλες και τυπώνουµε ξανά
τη δοµή του πίνακα κατηγορηµάτων

> db.describe -c corine_studyarea
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ncols: 7
nrows: 8703
Column 1: cat:INTEGER:20
Column 2: name:TEXT:99999
Column 3: code_00:INTEGER:20
Column 4: code:INTEGER:20
Column 5: rgb:TEXT:255
Column 6: grassrgb:TEXT:255
Column 7: area_ha:DOUBLE PRECISION:20
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9 Ορισµός των επίσηµων χρωµάτων CORINE

9.1 Περιγραφή της διαδικασίας

Ο ορισµός συγκεκριµένων τιµών των χρωµάτων κόκκινου - πράσινου - µπλε (ΚΠΜ)
9.1 για κάθε κατηγορία κάλυψης/χρήσης γης χωριστά είναι χρονοβόρα εργασία. Με
το GRASS η εργασία αυτή µπορεί να αυτοµατοποιηθεί όταν προϋπάρχουν χρωµατικοί
συνδυασµοί ΚΠΜ υπό µορφή απλού κειµένου ή ως δεδοµένα λογιστικού ϕύλλου.

Οι χρωµατικοί συνδυασµοί µπορούν να αποτελέσουν µια στήλη µε το όνοµα grassrgb

στον πίνακα των κατηγορηµάτων ενός διανυσµατικού χάρτη. Η στήλη αυτή µπορεί να
χρησιµοποιηθεί άµεσα από το εργαλείο d.vect για την επιθυµητή χρωµατική απόδοση
του χάρτη.

Οι τιµές ΚΠΜ πρέπει να είναι γραµµένες µε τον ακόλουθο τρόπο: κκκ:πππ:µµµ, όπου
τα κκκ, πππ και µµµ αναπαριστούν έναν τριψήφιο αριθµό που κυµαίνεται από το 0
µέχρι το 255 και αντιστοιχεί στην ένταση του κόκκινου, του πράσινου και του µπλε
χρώµατος. Επειδή είναι απαραίτητη η χρήση της διπλής τελείας (:) ως διαχωριστικός
χαρακτήρας για τις τιµές ΚΠΜ, το πεδίο του κατηγορήµατος grassrgb πρέπει να έχει
µήκος 11 χαρακτήρων και να είναι τύπου varchar.

Ανάλογα µε τη µορφή στην οποία διατίθενται οι τιµές ΚΠΜ πρέπει να ϐρεθεί ένας
τρόπος (α) εισαγωγής των στον πίνακα κατηγορηµάτων του διανυσµατικού χάρτη, (ϐ)
µετατροπής των, αν είναι απαραίτητο, στην µορφή που το GRASS µπορεί να διαβάσει
(µορφή, τύπος και µήκος του πεδίου) και (γ) µεταφορά των τιµών σε µια στήλη µε το
όνοµα grassrgb και ταυτόσηµα χαρακτηριστικά (τύπος και µήκος πεδίου).

Πρώτα εισαγάγουµε τις τιµές ΚΠΜ ως ξεχωριστό πίνακα στην ϐάση δεδοµένων και τις
ενσωµατώνουµε στον πίνακα κατηγορηµάτων του τελικού χάρτη. Για την υλοποίηση
της ενσωµάτωσης (join) µιας στήλης ενός πίνακα σε έναν άλλο πίνακα µέσα στην ίδια
ϐάση δεδοµένων, είναι απαραίτητη η ύπαρξη µιας στήλης και στους δύο πίνακες µε
ταυτόσηµα το περιεχόµενο και τον τύπο του πεδίου, όχι όµως του ονόµατος. Η µετα-
τροπή και µεταφορά των τιµών στην κατάλληλη µορφή και στήλη γίνεται σε ένα ϐήµα
µε τη χρήση εντολής συνταγµένης στη γλώσσα SQL9.2.
9.1ΚΠΜ= κόκκινο, πράσινο, µπλε από τον αντίστοιχο όρο στην Αγγλική γλώσσα RGB= red, green, blue)
9.2http://www.sqlite.org/lang.html

http://www.sqlite.org/lang.html


9 Ορισµός των επίσηµων χρωµάτων CORINE

9.2 Εφαρµογή

Κατεβάζουµε το αρχείο csv9.3 που περιέχει τους επίσηµους χρωµατικούς συνδυασµούς
και:

• Εισαγάγουµε το αρχείο csv σε ένα λογιστικό ϕύλλο του OpenOffice.org: Εφαρ-
µογές > Γραφείο > Λογιστικό Φύλλο OpenOffice.org (προσέχουµε τον χαρακτήρα
που ϑα χρησιµοποιηθεί ως διαχωριστικό πεδίων κατά την εισαγωγή του αρχείου)

• Επιλέγουµε τις 2 στήλες που µας ενδιαφέρουν (code και rgb) και τις αντιγράφουµε
σε ένα νέο λογιστικό ϕύλλο

• Αποθηκεύουµε το νέο λογιστικό ϕύλλο ως αρχείο csv (για παράδειγµα στον κατάλ-
ογο /home/user-id/grassdb/clc2000 ως corine_rgb.csv)

Πριν από την εισαγωγή του πίνακα επιβεβαιώνουµε την σύνδεση µε την ϐάση δεδοµένων
(sqlite.db). Αν δεν υφίσταται η σύνδεση µε τη ϐάση δεδοµένων η εισαγωγή των τιµών
ΚΠΜ ϑα αποτύχει. ΄Επειτα εισαγάγουµε ως νέο πίνακα τις τιµές ΚΠΜ9.4 στην ϐάση
δεδοµένων

> db.in.ogr clc_rgb.csv out=corine_rgb

Οι στήλες code και rgb πρέπει να µετατραπούν σε integer και varchar(11) αντίστοιχα.
Πραγµατοποιούµε τις µετατροπές µε το sqlitebrowser µε τον γνωστό από πριν τρόπο
(σελίδα 45). ΄Επειτα ενσωµατώνουµε τη στήλη code του νεοεισηγµένου πίνακα στον
πίνακα κατηγορηµάτων του χάρτη corine_studyarea ϐάσει της στήλης code_00
του τελευταίου

> v.db.join map=corine_studyarea layer=1 column=
code_00 otable=corine_rgb ocolumn=code

Η επιτυχία της ενσωµάτωσης µπορεί να επιβεβαιωθεί ως εξής:

> db.select corine_studyarea

Παρατηρούµε ότι ενσωµατώθηκαν όλες οι στήλες στον πίνακα αποδέκτη. ΄Οσες από τις
στήλες δεν χρειαζόµαστε µπορούµε να τις διαγράψουµε αργότερα. Συνεχίζουµε µε την
πρόσϑεση της επιθυµητής στήλης grassrgb

9.3Στον ιστότοπο του ΕΟΠ http://dataservice.eea.europa.eu/dataservice/metadetails.
asp?id=950 επιλέγουµε το σύνδεσµο Ascii delimited

9.4ουσιαστικά το αρχείο clc_rgb.csv
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9.2 Εφαρµογή

> v.db.addcol map=corine_studyarea column="grassrgb
varchar(11)"

Μεταµορφώνουµε τις διαθέσιµες τιµές χρωµατικών συνδυασµών στην µορφή κκκ:πππ:µµµ

και τις µεταφέρουµε στην στήλη grassrgb µε µια σύνθετη εντολή

> echo "UPDATE clc00_StudyArea SET grassrgb =
(substr(rgb,1,3)||’:’||substr(rgb,5,3)||’:’||
substr(rgb,9,3))" | db.execute

Επιβεβαιώνουµε το αποτέλεσµα της προηγούµενης ενέργειας µε

> db.describe -c corine_studyarea

ή/και

> db.select corine_studyarea

∆ιαγράφουµε τις αχρείαστες στήλες code_00 και rgb µε τον περιηγητή sqlitebrowser.
Τώρα µπορούµε να προβάλλουµε ένα χάρτη corine µε την σωστή χρωµατική απόδοση.
Εκκινούµε ένα παράθυρο X και προβάλλουµε τον τελικό χάρτη (εικόνα 9.1) ως εξής:

> d.mon x0
> d.vect corine_studyarea type=area size=0 width=0

rgb_column=grassrgb -a

Η προβολή του χάρτη µέσα από τον ∆ιαχειριστή του ΣΓΠ γίνεται ως εξής: Add vector
layer > ϕορτώνουµε τον χάρτη corine_studyarea > απενεργοποιούµε την επιλογή Draw
lines και ενεργοποιούµε την επιλογή GRASSRGB column colors.

'
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∆εν ξεχνούµε ότι εργαστήκαµε σε µια τοποθεσία ορισµένη ϐάσει του προβολικού συστή-
µατος ETRS89. Η επαναπροβολή του χάρτη σε κάποιο άλλο προβολικό σύστηµα
µπορεί να γίνει αφού πρώτα δηµιουργηθεί µια νέα τοποθεσία, ορισµένη από το
επιθυµητό προβολικό σύστηµα.
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9 Ορισµός των επίσηµων χρωµάτων CORINE

Εικόνα 9.1: Ο χάρτης CORINE για την Πελοπόννησο

56



10 Εκτιµήσεις ανά κατηγορία CORINE

Τελευταία µας ενέργεια είναι να προσϑέσουµε µια στήλη µε τις εκτιµήσεις των εµβαδών
για κάθε πολύγωνο:

> v.db.addcol corine col="area_ha double precision"

Εκτιµούµε το εµβαδόν για κάθε πολύγωνο

> v.to.db map=corine type=boundary,centroid option=
area units=h columns=area_ha

Επί του παρόντος δεν υπάρχει η δυνατότητα άθροισης όλων των εµβαδών ϐάσει κατη-
γορήµατος (π.χ. ο κωδικός κάλυψης/χρήσης γης) στο εργαλείο v.report ή σε κάποιο
άλλο εργαλείο που διαχειρίζεται ανυσµατικά δεδοµένα. Οπότε χρησιµοποιούµε ένα
σύνθετο ερώτηµα SQL και προωθούµε το αποτέλεσµα στο εργαλείο db.select για να το
προβάλλουµε στο τερµατικό.

> echo "select code, sum(area_ha) from
corine_studyarea group by code" | db.select

code|sum(area_ha)
111|911.125919
112|18378.199764
121|1954.70496
[...]
334|3930.685132
411|1688.078293
421|1388.759659
422|90.039538
511|1404.862058
512|2386.576137
521|355.55877



10 Εκτιµήσεις ανά κατηγορία CORINE

Μια πολύ καλή άσκηση είναι η πρόσϑεση της ονοµατολογίας των κατηγοριών της ϐάσης
δεδοµένων CORINE. Επιπλέον, η προβολή του χάρτη στο Ελληνικό Γεωδαιτικό Σύστηµα
Αναφοράς 1987 (ΕΓΣΑ8710.1, 10.2) προϋποθέτει την δηµιουργία µια τοποθεσίας µε ϐάση
το εν λόγω σύστηµα αναφοράς συντεταγµένων και την µετατροπή του από το ETRS89
στη νέα τοποθεσία µε το εργαλείο v.proj.

Τερµατίσατε σωστά το τερµατικό; Είναι σκόπιµο να τερµατίζεται η λειτουργία του
GRASS πληκτρολογώντας exit στο τερµατικό.

Καλή συνέχεια!

10.1Κωδικός EPSG: 2100
10.2Στην Αγγλική γλώσσα το ΕΓΣΑ87 αναφέρεται ως GGRS87(=Greek Geodetic Reference System 1987) ή

ως HGRS87 (= Hellenic Geodetic Reference System 1987). Συχνά αναφέρεται εσϕαλµένα ως EGSA87.
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Μέρος III

Ο ‘‘ελληνικός’’ χάρτης CORINE
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Με µια µατιά...

• Βήµα 1ο

◦ Λήψη του αρχείου GR_100K.shp που αναπαριστά γεωγραφικά τα “ελλη-
νικά” πλακίδια CORINE10.3 και των διοικητικών ορίων της Ευρώπης NUTSV910.4

• Βήµα 2ο

◦ Εισαγωγή του αρχείου GR_100K.shp και δηµιουργία λίστας µε τα Ϲητού-
µενα πλακίδια

◦ Λήψη των πλακιδίων CORINE που καλύπτουν την Ελλάδα10.5

• Βήµα 3ο

◦ Εισαγωγή των πλακιδίων CORINE και των ορίων NUTSV9 στη ϐάση δε-
δοµένων

◦ ΄Ενωση των γεωµετριών (των πλακιδίων CORINE), τοπολογικές διορθώσεις
και συγχώνευση των γειτονικών γεωµετριών ϐάσει κοινού κωδικού κάλυψης/
χρήσης γης,

◦ Ενσωµάτωση του πίνακα κατηγορηµάτων και απόδοση της επίσηµης χρω-
µατικής κωδικοποίησης CORINE

• Βήµα 4ο

◦ ∆ηµιουργία χάρτη εθνικών ορίων (µε ϐάση το χάρτη NUTSV9) και υπέρθεση
αυτού στον χάρτη CORINE για απόρριψη των εκτός εθνικών ορίων περιοχών

• Βήµα 5ο

◦ Εκτίµηση εµβαδού ανά κατηγορία κάλυψης/ χρήσης γης και προβολή του
“ελ-ληνικού” χάρτη CORINE

10.3http://dataservice.eea.europa.eu/download.asp?id=18328&filetype=.zip
από http://dataservice.eea.europa.eu/dataservice/metadetails.asp?id=760

10.4http://dataservice.eea.europa.eu/download.asp?id=17888&filetype=.zip
από http://dataservice.eea.europa.eu/dataservice/metadetails.asp?id=1004

10.5από τον σύνδεσµο:
http://dataservice.eea.europa.eu/staticfiles/landcover_tiles_v2/[...],
όπου οι τρεις τελείες [...] πρέπει να αντικατασταθούν από το όνοµα του Ϲητούµενου πλακιδίου.

http://dataservice.eea.europa.eu/download.asp?id=18328&filetype=.zip
http://dataservice.eea.europa.eu/dataservice/metadetails.asp?id=760
http://dataservice.eea.europa.eu/download.asp?id=17888&filetype=.zip
http://dataservice.eea.europa.eu/dataservice/metadetails.asp?id=1004
http://dataservice.eea.europa.eu/staticfiles/landcover_tiles_v2/[...]




11 Λήψη των πλακιδίων CORINE

# τα πλακίδια που συστοιχειώνουν το “ελληνικό” CORINE αναπαριστώνται στο διανυ-
σµατικό αρχείο GR_100K.shp11.1, 11.2

# αναφέρονται µε την ακριβή τους ονοµασία στη στήλη(=κατηγόρηµα) CellCode. 11.3

# εκκίνηση του grass στην τοποθεσία laea

# σύνδεση της ϐάση δεδοµένων grass µε τη ϐάση δεδοµένων των πινάκων κατηγορηµάτων11.4

> db.connect driver=sqlite database=/geo/grassdb/
ellas/laea/PERMANENT/sqlite.db

# έλεγχος µε db.connect -p

# εισαγωγή του αρχείου GR_100K.shp στη ϐάση δεδοµένων grass

> v.in.ogr dsn=/geo/geodata/ellas/vector/eea/
eea_reference_grid_el/GR_100K.shp out=eea_gr_100k

# τυπώνουµε τις πρώτες 10 εγγραφές του πίνακα κατηγορηµάτων eea_gr_100k

> db.select eea_gr_100k | head

11.1Λήψη του αρχείου http://dataservice.eea.europa.eu/download.asp?id=
18328&filetype=.zip
από τον ιστότοπο http://dataservice.eea.europa.eu/dataservice/metadetails.
asp?id=760

11.2Στην άσκηση που παρουσιάζεται εδώ το αρχείο GREEA18328I.zip µετονοµάστηκε σε GR_100K.shp
11.3Στην εικόνα 11.1 το Quantum GIS, ένα πολύ εύχρηστο εργαλείο προβολής και περιορισµένης (σχετικά

και προς το παρόν!) ανάλυσης γεωχωρικών δεδοµένων
11.4εδώ εννοείται η σύνδεση της ϐάσης γεωχωρικών δεδοµένων GRASS (δηλαδή η συλλογή χαρτών στην

οποία εργαζόµαστε κάθε ϕορά) µε το αρχείο - ϐάση δεδοµένων στο οποίο αποθηκεύονται οι πίνακες
κατηγορηµάτων των διανυσµατικών χαρτών.

http://dataservice.eea.europa.eu/download.asp?id=18328&filetype=.zip
http://dataservice.eea.europa.eu/download.asp?id=18328&filetype=.zip
http://dataservice.eea.europa.eu/dataservice/metadetails.asp?id=760
http://dataservice.eea.europa.eu/dataservice/metadetails.asp?id=760


11 Λήψη των πλακιδίων CORINE

Εικόνα 11.1: Τα πλακίδια πλευράς 100 χλµ. που καλύπτουν την Ελλάδα

cat|CellCode|EofOrigin|NofOrigin
1|100kmE51N18|5100000|1800000
2|100kmE51N19|5100000|1900000
3|100kmE52N16|5200000|1600000
4|100kmE52N17|5200000|1700000
5|100kmE52N18|5200000|1800000
6|100kmE52N19|5200000|1900000
7|100kmE52N20|5200000|2000000
8|100kmE53N15|5300000|1500000
9|100kmE53N16|5300000|1600000
10|100kmE53N17|5300000|1700000

# γνωρίζουµε πλέον ότι η στήλη CellCode είναι η 2η

# τυπώνουµε επιλεκτικά *µόνον* αυτή χρησιµοποιώντας την εντολή cut

> db.select eea_gr_100k -c | cut -d"|" -f2

100kmE51N18
100kmE51N19
100kmE52N16
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100kmE52N17
100kmE52N18
100kmE52N19
[...]

# διοχετεύουµε τα περιεχόµενα της 2ης στήλης, δηλαδή τα ονόµατα των πλακιδίων που
καλύπτουν την Ελλάδα, σε ένα νέο αρχείο

> db.select eea_gr_100k -c | cut -d"|" -f2 >
corine_v2_tiles_ellas

# δηµιουργούµε έναν κατάλογο στον οποίο ϑα κατεβάσουµε τα πλακίδια

> mkdir pool
> cd pool

# λαµβάνουµε τα πλακίδια εκτελώντας την εντολή wget µέσα σε ένα ϐρόχο for

> for x in ‘cat corine_tiles_ellas‘; do wget http://
dataservice.eea.europa.eu/staticfiles/
landcover_tiles_v2/$x.zip; done

--2009-01-12 15:12:26-- http://dataservice.eea.
europa.eu/staticfiles/landcover_tiles_v2/100
kmE51N18.zip

Resolving dataservice.eea.europa.eu... 217.74.209.209
[...]
Saving to: ‘100kmE51N18.zip’
100%
[============================>] 408,346 1.12M/s

in 0.3s

2009-01-12 15:12:27 (1.12 MB/s) - ‘100kmE51N18.zip’
saved [408346/408346]

[...]

# αποσυµπιέζουµε τα ληφθέντα αρχεία

> unzip \∗ . z ip
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12 ΄Ενωση των πλακιδίων σε ένα χάρτη

# εισαγάγουµε τους επιµέρους διανυσµατικούς χάρτες (πλακίδια) στη ϐάση δεδοµένων
του grass

> for x in *.shp; do v.in.ogr dsn=$x out=tile_‘
basename $x .shp‘; done

# ενώνουµε τις χωριστές γεωµετρίες των πλακιδίων σε ένα διανυσµατικό χάρτη

> for x in ‘g.mlist vect pat=tile_* sep=,‘; do
v.patch -e --o in=$x out=
corine_ellas_tiles_patched; done

# *απαραίτητη* η διόρθωση τοπολογικών σϕαλµάτων

> v.clean corine_ellas_tiles_patched out=
corine_ellas_patched_clean tool=snap,break,rmdupl
thresh=.01

# συγχώνευση ταυτόσηµων γειτονικών γεωµετριών

# πρώτα έλεγχος των στηλών12.1

> v.info -c corine_ellas_patched_clean

12.1Είναι σηµαντικό οι τίτλοι των πεδίων που περιέχουν τα κατηγορήµατα (=οι τίτλοι των στηλών - όχι τα ίδια τα
κατηγορήµατα ) να είναι γραµµένοι µε µικρά. Ο λόγος είναι ότι τίτλοι πεδίων µε κεφαλαία συγχέονται,
συχνά, µε όρους-εντολές SQL µε αποτέλεσµα να δηµιουργούνται προβλήµατα κατά τη διαχείριση µια
ϐάσης δεδοµένων. Στην προκειµένη περίπτωση δεν ϑα ασχοληθούµε µε την µετονοµασία ή την προσ-
ϑαφαίρεση των στηλών αφού, όλες οι στήλες, ϑα χαθούν µετά τη συγχώνευση (v.dissolve). Σε κάποιο
από τα επόµενα ϐήµατα ϑα προσθέσουµε τον πίνακα που χρειαζόµαστε (ονοµατολογία κατηγοριών
CORINE και επίσηµοι χρωµατικοί συνδυασµοί).



12 ΄Ενωση των πλακιδίων σε ένα χάρτη

Displaying column types/names for database connection
of layer 1:

INTEGER|cat
CHARACTER|CODE_00
DOUBLE PRECISION|AREA

# µας ενδιαφέρει η στήλη CODE_00

# o τύπος πεδίου της στήλης στην οποία ϑα ϐασιστεί η λειτουργία της συγχώνευσης να
µετατραπεί σε integer 12.2

# µετατροπή µε sqlitebrowser

# αλλιώς v.db.addcol column=’somename integer’+ v.db.update

> v.dissolve corine_ellas_patched_clean out=
corine_ellas_clean_dissolved column=CODE_00

# o “νέος” πίνακας πρέπει να προστεθεί στη ϐάση δεδοµένων sqlite.db

v.db.addtable corine_ellas_clean_dissolved

# ελέγχουµε ποιες στήλες υπάρχουν στον πίνακα κατηγορηµάτων που είναι συνδ-
εδεµένος µε το χάρτη corine_ellas_tiles_patched

db.describe corine_ellas_clean_dissolved -c

ncols: 1
nrows: 39
Column 1: cat:INTEGER:20

# η µοναδική στήλη cat περιέχει τώρα την κωδικοποίηση CORINE

# εισαγωγή του πίνακα κατηγορηµάτων CORINE και των χρωµατικών συνδυασµών
(=στήλη grassrgb)12.3

> db.in.ogr dsn=/geo/geodata/europe/
corine_levels_lables_grassrgb/
corine_levels_labels_grassrgb.csv out=
corine_levels_labels_grassrgb

12.2ϐλέπε κεφάλαιο 7, στη σελίδα 46
12.3ϐλέπε Παράρτηµα, αρχείο corine_levels_labels_grassrgb.csv, σελίδα 83
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# έλεγχος

db.tables -p

# ή/ και µε db.select corine_levels_labels_grassrgb | head

# ενσωµάτωση του πίνακα ϐάσει του τρίτου επιπέδου κατηγοριών CORINE12.4

> v.db.join corine_ellas_clean_dissolved column=cat
otable=corine_levels_labels_grassrgb ocolumn=
level3

# έλεγχος µε db.describe -c corine_ellas_clean_dissolved ή

db.select corine_ellas_clean_dissolved | head

[...]

# προβολή του χάρτη

> d.mon x0
> d.erase grey # this is optional!
> d.vect -a corine_ellas_clean_dissolved color=none

type=area

12.4Βλέπε ϐοήθεια του v.db.join για σηµαντικές λεπτοµέρειες
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13 Κόψιµο του χάρτη στα ‘‘µέτρα’’ της Ελλάδας

'
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Στο σηµείο αυτό παρουσιάζεται ένας ακόµη τρόπος για την δηµιουργία µάσκας µε την
χρήση της οποίας ϑα κοπούν οι περιοχές έξω από τα εθνικά όρια. Προϋπόθεση είναι
να υπάρχει κάποιος διανυσµατικός χάρτης. Η διαδικασία περιλαµβάνει µετατροπή του
διανυσµατικού χάρτη σε ψηφιδωτό όπου όλες οι ψηφίδες ϑα λάβουν την ίδια τιµή και
έπειτα την επαναµετατροπή σε διανυσµατικό χάρτη.

Με τη µέθοδο αυτή αποφεύγονται συχνά δυσκολίες που σχετίζονται µε τοπολογικά
σφάλµατα. Πρέπει όµως να υλοποιείται µε προσοχή: να επιλεγεί ορθά η γεωµετρική
ανάλυση του ψηφιδωτού χάρτη που ϑα δηµιουργηθεί ώστε να αλλοιωθούν κατά το
λιγότερο δυνατόν οι αρχικές (στην περίπτωση µας οι εξωτερικές) γεωµετρίες (=σύνορα
και ακτογραµµή). Να ληφθεί υπόψη ότι πρόκειται για µια απλή µεν, χρονοβόρα δε
διαδικασία εξαιτίας της µετατροπής.

# επειδή τα πλακίδια εξέχουν των εθνικών ορίων στα ϐόρεια είναι απαραίτητη η τµήση
του ενιαίου χάρτη ϐάσει των εθνικών ορίων

# εθνικά όρια µπορούν να σχηµατιστούν από το χάρτη διοικητικών ορίων NUTSV9

# εισαγάγουµε το χάρτη NUTSV9 στην τοποθεσία laea

> v.in.ogr dsn=NUTSV9_LEAC.shp output=nutsv9 min_area
=0.0001 snap=-1

# εξάγουµε τις “ελληνικές” γεωµετρίες ϐάσει του κατηγορήµατος N0CD

> v.extract input=nutsv9 output=nutsv9_ellas type=
boundary,centroid,area layer=1 new=-1 where=’N0CD
="GR"’

# ορισµός της ενεργού περιοχής και του µεγέθους (πλευρά) των εικονοστοιχείων (=ανάλυση)

# στο παράδειγµα αυτό 250µ



13 Κόψιµο του χάρτη στα “µέτρα” της Ελλάδας

Εικόνα 13.1: Ο “ελληνικός” χάρτης CORINE

> g.region vect=nutsv9 res=250 -pa

# µετατροπή σε ψηφιδωτό χάρτη

# ο χάρτης που ϑα προκύψει ϑα έχει τιµές *µπερδεµένες*, ϐασισµένες στο κατηγόρηµα
cat του αρχικού (διανυσµατικού) χάρτη

> v.to.rast input=nutsv9_ellas output=nutsv9_ellas
use=cat type=area layer=1 value=1 rows=4096

# δηµιουργία ενιαίας επιφάνειας

# παράγουµε ένα νέο ψηφιδωτό χάρτη στον οποίο και δίνουµε σε όλα τα *µη-στοιχεία*13.1, 13.2

την τιµή ένα

�



�
	Το GRASS διαχωρίζει τις µηδενικές τιµές (οι οποίες είναι τιµές) από τα µη-στοιχεία τα

οποία χαρακτηρίζονται ως nodata ή NULL

13.1κατά το αγγλικό no-data ή NULL
13.2Βλέπε την παράγραφο NULL support στην ϐοήθεια του r.mapcalc http://grass.osgeo.org/

grass64/manuals/html64_user/r.mapcalc.html
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r.mapcalc ellas=’if(nutsv9_ellas != 0, 1, null())’

# (επανα-)µετατροπή σε διανυσµατικό χάρτη

# εδώ υπάρχει η δυνατότητα να χρησιµοποιηθεί η παράµετρος -s(=smooth) η οποία ϑα
στρογγυλέψει σχετικά τα παραγόµενα διανύσµατα

r.to.vect -s input=ellas output=ellas feature=area

# υπέρθεση των εθνικών ορίων ellas στο χάρτη corine_ellas_clean_dissolved13.3

και εξαγωγή των περιοχών που αλληλοκαλύπτονται

> v.overlay ainput=corine_ellas_clean_dissolved atype
=area binput=ellas btype=area output=
corine_ellas_v2 operator=and olayer=1,0,0

v.info -c corine_ellas_v2

INTEGER|cat
INTEGER|a_cat
CHARACTER|a_level1
CHARACTER|a_label1
CHARACTER|a_label1_el
CHARACTER|a_level2
CHARACTER|a_label2
CHARACTER|a_label2_el
CHARACTER|a_level3
CHARACTER|a_label3
CHARACTER|a_label3_el
CHARACTER|a_grassrgb
INTEGER|b_cat
INTEGER|b_value
CHARACTER|b_label

# µετά το v.overlay οι στήλες µετονοµάζονται ώστε να είναι κατανοητό από ποιο χάρτη
προέρχονται

# επειδή όµως η στήλη grassrgb πρέπει να έχει ακριβώς αυτό το όνοµα και µόνο,
είναι *απαραίτητη* η επεξεργασία της από a_grassrgb σε grassrgb ώστε να µπορεί
να εµφανιστεί χρωµατικά “σωστά” ο χάρτης!

# και εδώ sqlitebrowser και µετά... d.vect
13.3Το στιγµιότυπο πριν την απόρριψη των εκτός εθνικών ορίων (=κόκκινα όρια) περιοχών
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14 Εκτιµήσεις και προβολή του ‘‘ελληνικού’’
χάρτη CORINE

# προβολή του πολύχρωµου χάρτη, µε κλίµακα και το δείκτη ϐορρά (η εικόνα του
εξωφύλλου)

> d.mon x0
> d.erase grey
> d.vect corine_ellas -a type=area color=none
> d.barscale at=17,94 bcolor=150:150:150 tcolor=250:

250:250 -s
> d.barscale at=80,10 bcolor=150:150:150 tcolor=250:

250:250 -n

Εικόνα 14.1: Ο “ελληνικός” χάρτης CORINE προβεβληµένος στο σύστηµα ETRS-LAEA



14 Εκτιµήσεις και προβολή του “ελληνικού” χάρτη CORINE

# για ένα γρήγορο στιγµιότυπο µπορεί να προσαρµοστεί το µέγεθος του παραθύρου
προβολής µε το ποντίκι

# πρόσϑεση στηλών στον πίνακα κατηγορηµάτων για τον υπολογισµό επιφανειών14.1

> v.db.addcol corine_ellas column=’area double
precision, area_ha double precision’

> v.to.db corine_ellas option=area units=me column=
area

> v.to.db corine_ellas option=area units=h column=
area_ha

> echo "select cat, sum(area_ha) from corine_ellas
group by cat" | db.select

Εικόνα 14.2: Στιγµιότυπο από το τερµατικό του GRASS: εµβαδόν ανά κατηγορία
CORINE στην Ελλάδα

14.1σε τ.µ. και εκτάρια ( 10.000 τ.µ. ή sq.m. ή m2 = 1 εκτάριο ή Ha )
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Η τρισδιάστατη απεικόνιση του τελικού αποτελέσµατος (εικόνα (14.3)) δηµιουργήθηκε
µε το NVIZ: http://grass.itc.it/nviz

Εικόνα 14.3: Ο χάρτης CORINE επί του ψηφιακού υψοµετρικού µοντέλου SRTM3

Το GRASS είναι ένα πολυδύναµο εργαλείο. Εξερεύνησέ το ;-)
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A Η ταξινόµηση CORINE στην ελληνική γλώσσα

Η ενδεικτική απόδοση των ορισµών των κατηγοριών κάλυψης/χρήσης γης στην Ελλη-
νική γλώσσα αφορά µόνο στο 3ο επίπεδο της ταξινόµησης CORINE και έγινε από τους
Νίκο Αλεξανδρή, Φώτη Ξυστράκη, ∆ηµήτρη Σαµαρά.

Η εύρεση ληµµάτων που µεταφράζουν επακριβώς τους ορισµούς µε την επιστηµονική
τους σηµασία είναι συχνά δύσκολη άσκηση. Για το λόγο αυτό είναι σκόπιµος ο σχο-
λιασµός του ορισµού Ζώνες µεταβατικής δασικής ϐλάστησης (324). Οι εν λόγω Ϲώνες

περιλαµβάνουν υποβαθµισµένα δασικά οικοσυστήµατα (οπισθοδροµική διαδοχή) και
περιοχές αναγέννησης - δάσωσης (προοδευτική διαδοχή).

Κατηγορία
κάλυψης/χρήσης Ονοµατολογία

111 Συνεχής αστικός ιστός

112 Ασυνεχής αστικός ιστός

121 Βιοµηχανικές ή εµπορικές µονάδες

122 Οδικό, σιδηροδροµικό δίκτυο και συναφείς εκτάσεις

123 Λιµάνια

124 Αεροδρόµια

131 Μεταλλευτικές περιοχές

132 Χώροι απόθεσης απορριµάτων

133 Εργοτάξια

141 Περιοχές αστικού πρασίνου

142 Εγκαταστάσεις αναψυχής και αθλητισµού

211 Μη αρδευόµενες αρόσιµες εκτάσεις

212 Μόνιµα αρδευόµενες εκτάσεις

213 Ορυζώνες



A Η ταξινόµηση CORINE στην ελληνική γλώσσα

Κατηγορία
κάλυψης/χρήσης Ονοµατολογία

221 Αµπελώνες

222 Οπωρώνες και καλλιέργειες

223 Ελαιώνες

231 Βοσκοτόπια

241 Ετήσιες µόνιµες καλλιέργειες

242 Συµπλέγµατα καλλιεργειών

243 Αγροτικές εκτάσεις µε σηµαντικό ποσοστό ϕυσικής ϐλάστησης

244 Περιοχές αγροδασοπονίας

311 ∆άση πλατύφυλλων

312 ∆άση κωνοφόρων

313 Μικτά δάση

321 Ποολίβαδα

322 Τυρφοέλη και χαµηλή ξυλώδης ϐλάστηση

323 Σκληρόφυλλη ϐλάστηση

324 Ζώνες µεταβατικής δασικής ϐλάστησης

331 Παραλίες, αµµοθίνες και αµµώδεις εκτάσεις

332 Βράχια

333 Περιοχές µε σποραδική ϐλάστηση

334 Καµένες περιοχές

335 Παγετώνες και αιώνιο χιόνι

411 Χερσαία έλη

412 Τυρφώνες

421 Αλατούχα έλη

422 Αλυκές

423 Παλλιροϊκοί σχηµατισµοί
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Κατηγορία
κάλυψης/χρήσης Ονοµατολογία

511 Υδάτινα ϱεύµατα

512 Λίµνες, αποταµιευτήρες και αντιπληµµυρικές Ϲώνες

521 Λιµνοθάλασσες

522 Εκβολές ποταµών

523 Θάλασσα
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B Οι κατηγορίες CORINE υπό µορφή csv

Το αρχείο corine_levels_labels_grassrgb.csvB.1 περιέχει την κωδικοποίηση
των κατηγοριών CORINE, τις επίσηµες ονοµασίες και την απόδοση των όρων στην Ελλ-
ηνική γλώσσα. Οποιοδήποτε κείµενο µπορεί να υποστεί επεξεργασία ποικιλοτρόπως
υπό το linuxB.2 και, ϐέβαια, µπορεί να εισαχθεί στη ϐάση δεδοµένων GRASS. Η στήλη
grassrgb είναι απαραίτητη για την αυτόµατη χρωµατική προβολή του χάρτη CORINE.

"level1","label1","label1_el","level2","label2","label2_el","level3","label3","label3_el","grassrgb"

1,"Artificial surfaces","Τεχνητές επιφάνειες",11,"Urban fabric","Αστικές
κατασκευές",111,"Continuous urban fabric","Συνεχής αστικός ιστός","230:000:077"

1,"Artificial surfaces","Τεχνητές επιφάνειες",11,"Urban fabric","Αστικές
κατασκευές",112,"Discontinuous urban fabric","Ασυνεχής αστικός ιστός","255:000:000"

1,"Artificial surfaces","Τεχνητές επιφάνειες",12,"Industrial, commercial and transport
units","Βιοµηχανικές, εµπορικές και µεταφορικές µονάδες",121,"Industrial or commercial
units","Βιοµηχανικές ή εµπορικές µονάδες","204:077:242"

1,"Artificial surfaces","Τεχνητές επιφάνειες",12,"Industrial, commercial and transport
units","Βιοµηχανικές, εµπορικές και µεταφορικές µονάδες",122,"Road and rail networks and
associated land","Οδικό, σιδηροδροµικό δίκτυο και οι συναφείς τους εκτάσεις","204:000:000"

1,"Artificial surfaces","Τεχνητές επιφάνειες",12,"Industrial, commercial and trans-
port units","Βιοµηχανικές, εµπορικές και µεταφορικές µονάδες",123,"Port ar-
eas","Λιµάνια","230:204:204"

1,"Artificial surfaces","Τεχνητές επιφάνειες",12,"Industrial, commer-
cial and transport units","Βιοµηχανικές, εµπορικές και µεταφορικές
µονάδες",124,"Airports","Αεροδρόµια","230:204:230"

1,"Artificial surfaces","Τεχνητές επιφάνειες",13,"Mine, dump and construction sites","Μεταλλεία,
σκουπιδότοποι και εργοτάξια",131,"Mineral extraction sites","Μεταλλεία","166:000:204"

1,"Artificial surfaces","Τεχνητές επιφάνειες",13,"Mine, dump and construction sites","Μεταλλεία,
σκουπιδότοποι και εργοτάξια",132,"Dump sites","Χώροι απόθεσης απορριµάτων","166:077:000"

1,"Artificial surfaces","Τεχνητές επιφάνειες",13,"Mine, dump and construction sites","Μεταλλεία,
σκουπιδότοποι και εργοτάξια",133,"Construction sites","Εργοτάξια","255:077:255"

B.1csv= comma separated values, τιµές διαχωρισµένες µε κόµµα
B.2µε εντολές-εργαλεία *nix όπως για παράδειγµα: cut, tr, sed και άλλα



B Οι κατηγορίες CORINE υπό µορφή csv

1,"Artificial surfaces","Τεχνητές επιφάνειες",14,"Artificial non-agricultural vegetated ar-
eas","Τεχνητές µη αγροτικές εκτάσεις µε ϐλάστηση",141,"Green urban areas","Περιοχές αστικού
πρασίνου","255:166:255"

1,"Artificial surfaces","Τεχνητές επιφάνειες",14,"Artificial non-agricultural vegetated ar-
eas","Τεχνητές µη αγροτικές εκτάσεις µε ϐλάστηση",142,"Sport and leisure facilities","Εγκαταστάσεις
αναψυχής και αθλητισµού","255:230:255"

2,"Agricultural areas","Αγροτικές περιοχές",21,"Arable land","Αρόσιµες εκτάσεις",211,"Non-
irrigated arable land","Μη αρδευόµενες αρόσιµες εκτάσεις","255:255:168"

2,"Agricultural areas","Αγροτικές περιοχές",21,"Arable land","Αρόσιµες εκτάσεις",212,"Permanently
irrigated land","Μόνιµα αρδευόµενες εκτάσεις","255:255:000"

2,"Agricultural areas","Αγροτικές περιοχές",21,"Arable land","Αρόσιµες εκτάσεις",213,"Rice
fields","Ορυζώνες","230:230:000"

2,"Agricultural areas","Αγροτικές περιοχές",22,"Permanent crops","Μόνιµες
καλλιέργειες",221,"Vineyards","Αµπελώνες","230:128:000"

2,"Agricultural areas","Αγροτικές περιοχές",22,"Permanent crops","Μόνιµες
καλλιέργειες",222,"Fruit trees and berry plantations","Οπωρώνες και καλλιέργειες","242:166:077"

2,"Agricultural areas","Αγροτικές περιοχές",22,"Permanent crops","Μόνιµες
καλλιέργειες",223,"Olive groves","Ελαιώνες","230:166:000"

2,"Agricultural areas","Αγροτικές περιοχές",23,"Pastures","Βοσκοτόπια",231,"Pastures","Βοσκοτόπια",
"230:230:077"

2,"Agricultural areas","Αγροτικές περιοχές",24,"Heterogeneous agricultural areas","Ετερογενείς
αγροτικές εκτάσεις",241,"Annual crops associated with permanent crops","Ετήσιες µόνιµες
καλλιέργειες","255:230:166"

2,"Agricultural areas","Αγροτικές περιοχές",24,"Heterogeneous agricultural ar-
eas","Ετερογενείς αγροτικές εκτάσεις",242,"Complex cultivation patterns","Συµπλέγµατα
καλλιεργειών","255:230:077"

2,"Agricultural areas","Αγροτικές περιοχές",24,"Heterogeneous agricultural areas","Ετερογενείς
αγροτικές εκτάσεις",243,"Land principally occupied by agriculture, with significant areas of natural
vegetation","Αγροτικές εκτάσεις µε σηµαντικό ποσοστό ϕυσικής ϐλάστησης","230:204:077"

2,"Agricultural areas","Αγροτικές περιοχές",24,"Heterogeneous agricultural areas","Ετερογενείς
αγροτικές εκτάσεις",244,"Agro-forestry areas","Περιοχές αγροδασοπονίας","242:204:166"

3,"Forests and semi-natural areas","∆άση και ϕυσικές περιοχές",31,"Forests","∆άση",311,"Broad-
leaved forest","∆άση πλατύφυλλων","128:255:000"

3,"Forests and semi-natural areas","∆άση και ϕυσικές περιο-
χές",31,"Forests","∆άση",312,"Coniferous forest","∆άση κωνοφόρων","000:166:000"

3,"Forests and semi-natural areas","∆άση και ϕυσικές περιοχές",31,"Forests","∆άση",313,"Mixed
forest","Μικτά δάση","077:255:000"

84



3,"Forests and semi-natural areas","∆άση και ϕυσικές περιοχές",32,"Shrub and/or
herbaceous vegetation associations","Θάµνοι και χορτολίβαδα",321,"Natural grass-
land","Ποολίβαδα","204:242:077"

3,"Forests and semi-natural areas","∆άση και ϕυσικές περιοχές",32,"Shrub and/or herbaceous
vegetation associations","Θάµνοι και χορτολίβαδα",322,"Moors and heathland","Χαµηλή ξυλώδης
ϐλάστηση","166:255:128"

3,"Forests and semi-natural areas","∆άση και ϕυσικές περιοχές",32,"Shrub and/or herbaceous
vegetation associations","Θάµνοι και χορτολίβαδα",323,"Sclerophyllous vegetation","Σκληρόφυλλη
ϐλάστηση","166:230:077"

3,"Forests and semi-natural areas","∆άση και ϕυσικές περιοχές",32,"Shrub and/or herbaceous
vegetation associations","Θάµνοι και χορτολίβαδα",324,"Transitional woodland-shrub","Ζώνες
µεταβατικής δασικής ϐλάστησης","166:242:000"

3,"Forests and semi-natural areas","∆άση και ϕυσικές περιοχές",33,"Open spaces with little or
no vegetation","Ανοιχτές περιοχές µε λίγη ή καθόλου ϐλάστηση",331,"Beaches, dunes, and sand
plains","Παραλίες, αµµοθίνες και αµµώδεις εκτάσεις","230:230:230"

3,"Forests and semi-natural areas","∆άση και ϕυσικές περιοχές",33,"Open spaces with
little or no vegetation","Ανοιχτές περιοχές µε λίγη ή καθόλου ϐλάστηση",332,"Bare
rock","Βράχια","204:204:204"

3,"Forests and semi-natural areas","∆άση και ϕυσικές περιοχές",33,"Open spaces with little
or no vegetation","Ανοιχτές περιοχές µε λίγη ή καθόλου ϐλάστηση",333,"Sparsely vegetated ar-
eas","Περιοχές µε σποραδική ϐλάστηση","204:255:204"

3,"Forests and semi-natural areas","∆άση και ϕυσικές περιοχές",33,"Open spaces with little or no
vegetation","Ανοιχτές περιοχές µε λίγη ή καθόλου ϐλάστηση",334,"Burned areas","Καµένες περιο-
χές","000:000:000"

3,"Forests and semi-natural areas","∆άση και ϕυσικές περιοχές",33,"Open spaces with little or
no vegetation","Ανοιχτές περιοχές µε λίγη ή καθόλου ϐλάστηση",335,"Glaciers and perpetual
snow","Παγετώνες και αιώνιο χιόνι","166:230:204"

4,"Wetlands","Υγρότοποι",41,"Inland wetlands","Υγρότοποι στην ενδοχώρα",411,"Inland
marshes","Χερσαία έλη","166:166:255"

4,"Wetlands","Υγρότοποι",41,"Inland wetlands","Υγρότοποι στην ενδο-
χώρα",412,"Peatbogs","Τυρφώδεις γαίες","077:077:255"

4,"Wetlands","Υγρότοποι",42,"Coastal wetlands","Παράκτιοι υγρότοποι",421,"Salt
marshes","Αλατώδη έλη","204:204:255"

4,"Wetlands","Υγρότοποι",42,"Coastal wetlands","Παράκτιοι υγρότοποι",422,"Salines","Αλυκές",
"230:230:255"

4,"Wetlands","Υγρότοποι",42,"Coastal wetlands","Παράκτιοι υγρότοποι",423,"Intertidal
flats","Παλλιροϊκοί σχηµατισµοί","166:166:230"
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B Οι κατηγορίες CORINE υπό µορφή csv

5,"Water bodies","Υδάτινοι όγκοι",51,"Inland waters","Υδάτινοι όγκοι στην ενδοχώρα",511,"Water
courses","Υδάτινα ϱεύµατα","000:204:242"

5,"Water bodies","Υδάτινοι όγκοι",51,"Inland waters","Υδάτινοι όγκοι στην ενδοχώρα",512,"Water
bodies","Λίµνες, αποταµιευτήρες και αντιπληµµυρικές Ϲώνες","128:242:230"

5,"Water bodies","Υδάτινοι όγκοι",52,"Marine waters","Θαλάσσιοι και παραθαλάσσιοι υδάτινοι
όγκοι",521,"Coastal lagoons","Λιµνοθάλασσες","000:255:166"

5,"Water bodies","Υδάτινοι όγκοι",52,"Marine waters","Θαλάσσιοι και παραθαλάσσιοι υδάτινοι
όγκοι",522,"Estuaries","Εκβολές ποταµών","166:255:230"

5,"Water bodies","Υδάτινοι όγκοι",52,"Marine waters","Θαλάσσιοι και παραθαλάσσιοι υδάτινοι
όγκοι",523,"Sea and ocean","Θάλασσα","230:242:255"
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